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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product
value chain.

Audience

This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.

Related Documents

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle
Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html contains
the latest versions of the Agile PLM PDF files. You can view or download these
manuals from the Web site, or you can ask your Agile administrator if there is an Agile
PLM Documentation folder available on your network from which you can access the
Agile PLM documentation (PDF) files.

Conventions
The following text conventions are used in this document:
Convention Meaning
boldface Boldface type indicates graphical user interface elements associated

with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.



Convention Meaning

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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About Agile PLM 9.3.6

This chapter contains important information about this product release.

Oracle Software Delivery Cloud Download Checklist

Oracle products are distributed as “Product Packs”. A Product Pack is an electronic
version of the software. Refer to the Media Pack description or the list of products that
you purchased on your Oracle Ordering Document.

Then, view the Quick Install Guide License List to help you decide which Product
Pack you need to select.

Prior to downloading, verify that the product you are looking for is in the License and
Options section of the Product Pack "Readme".

Oracle recommends that you print this "Readme" document for reference.

Please download each Product Pack from the Oracle Software Delivery Cloud web site
(https://edelivery.oracle.com/) as specified below.

1. Oracle Agile PLM Application Components
2. Oracle Fusion Middleware 12.2.1.1 infrastructure (includes WebLogic Server)
3. Oracle Database

There will be an itemized part list within each of the packs. You will need to download
all items in order to have the complete download for the desired Oracle Agile release.

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly
portable Zip utility. After downloading one or more of the archives, you will need the
UnZip utility (for UNIX or Windows platforms) or the WinZip utility (for Windows
platform) to extract the files. You must unzip the archive on the platform for which it
was intended.

Verity that the file size of your downloaded file matches the file size displayed on
Oracle Software Delivery Cloud.

Unzip each Zip file to its own temporary directory.

For example, create a directory structure called agile936downloads on your hard drive:
s c:\agile936downloads

Then create a new directory for each Zip file you downloaded:

s C:\agile936downloads\wlsl2

s C:\agile936downloads\AgilePLM936_Diskl
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Install and Test Notice

After extracting the software from the Zip files, you can install from your computer's
hard drive.

Install and Test Notice

Platform Support

Important: Install and test this release on a designated test server
before installing it on your production environment. Your test
environment should mirror your production environment as closely
as possible to provide accurate testing results. It is important to
validate the installation of this release, and confirm your integrations
are working correctly as part of your minimum due diligence. Any
problems or questions noted during your system testing should be
resolved before installing this release on your production
environment.

Refer to the Software Requirements section in the Agile PLM Capacity Planning Guide
for platform support details.

Minimum Versions of Additional Agile PLM Software

Agile PLM 9.3.6 requires new versions of OPLA, AutoVue, EC MCAD, EC ECAD,
PLM Mobile, D2R AIA PIP for EBS, D2R AIA PIP for SAP, and a patch to enable RMW
9.3.4. Please refer to the Agile PLM Capacity Planning Guide for specific version
information. These additional software components will release after the initial release
of Agile PLM 9.3.6.

Oracle Agile Product Overview Checklist

After reading the content of this Oracle Agile PLM release document, we suggest
performing the following tasks:

» Feature Review:

Review the New Features and Resolved Issues sections to make sure you
understand the overall product changes in this release.

m  Business Process Review:

After completing the New Feature and Resolved Issues review, make sure you
understand if any of your current business processes are impacted by this
release and/or if they might need to be modified and re-evaluated. This is a
very important preparation step as you move forward with implementing any
Agile release. Make sure all of your key business processes are thoroughly
documented and you have an overall business owner who understands each
process. Use this list of processes as a checklist against the features and
changes in this Agile release. You may want to assign a "weight" to each
change in terms of how significant an impact it has to your organization (think
about re-training users, changing current integrations, etc.)

s Identify resources to install and test this release.

Make sure that a test environment is ready and that tests have been developed
to ensure this release performs the functions necessary for your business.
Verify that the system can be rolled back in the unlikely event of a failure.
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New Features in Agile PLM Solutions

Make sure that your testing includes all aspects of the product features, all of
your business processes and any integration that you may have (AIS, SDK,
ChangeCAST, ACS, etc.). If considering switching to LDAP authentication,
come up with a plan to test the LDAP integration. Make sure to cover common
scenarios like changing password, removing a user, etc.

s Create an upgrade plan and strategy.

- For a release, we recommend engaging our Oracle Consulting Organization
for your upgrade. Validate the hardware configuration according to the
Capacity Planning Guide. If you plan to manage your own upgrade, create a
very detailed upgrade plan that includes a scheduled start time, an established
number of “dry” runs, a pre-determined rollout date, and a designated team
of individuals across your organization with detailed knowledge of product,
technology, networking, business process, etc.

= Prepare end-user training.

- We recommend exposing a number of your power users to the new version
well in advance of a production rollout to ensure that your users deeply
understand the product functionality. Much of the end user training will
actually begin during the testing phase. Use this feedback as a basis for your
overall end-user training.

Accessing Agile PLM Documentation

The following sections describe how to access Agile PLM documentation and sample
code and scripts.

PLM Solution and Administration Manuals

Please use this Web site to access your Agile PLM 9.3.x documentation, which includes
manuals about installing PLM, configuring and administering PLM, and all the PLM
solutions for users:

http://www.oracle.com/technetwork/documentation/agile-085940.html

Note: The documentation of Agile PLM 9.3.x is no longer accessed
through Metalink.

PLM Sample Code and Scripts

Sample code and scripts pertaining to Agile solutions may be found on the Oracle
Agile PLM Sample Code page:

http://www.oracle.com/technetwork/indexes/samplecode/agileplm-sample-52094
5.html

New Features in Agile PLM Solutions

For information about the new features and enhancements in this release, see the Agile
PLM 9.3.6 New Features Overview White Paper.
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Issues Resolved by Hot Fix Releases

Hot fixes included in this product release are:

PLM Release 9.3.1.0

9310_152

This section includes Hot Fixes included in Agile PLM 9.3.1.0.

Bug ID 23285323: PROJECTS SHOWING INCORRECT BASELINE DATESSEV 1 SR

Root Cause: When reading baseline contents from the database, the application always
uses the first parent id of one Activity, rather than its current parent id, which causes
an error if the activity has a changed parent.

Resolution: Explicitly pass the parent id when reading baseline contents.

PLM Release 9.3.1.2

9312_320

9312_324

9312_326

This section includes Hot Fixes included in Agile PLM 9.3.1.2.

Bug ID 22146467: SMART URL AND GET SHORTCUT URL ERRORS WITH
AUTOVUE ERROR

Root Cause: When the object attachment row is found, the code does not compare the
attachment file name.

Resolution: Need to compare file name when we get the file row.

Bug ID 22372971: AXML FILE MISSING RELATIONSHIPS TAB CURRENTSTATUS
VALUE

Root Cause: We currently export load the available life-cycle phases by class id, not
subclass id, so subclass-specific lifecycle phases can not be exported in the
Relationship tab as read-through attribute Current Status.

Resolution: Load the available lifecycle phases by subclass id.

Bug ID 22668498: PRICE EFFECTIVE DATE REDUCED ONE DAY DURING IMPORT

Issues Resolved by Hot Fix Releases 2-1



PLM Release 9.3.2.0

Root Cause: Import uses the import user's time zone setting to convert string to date
for the date only attribute.

Resolution: Always use GMT time zone to convert string to date for date only
attribute.

9312_332

Bug ID 24390300: INTERNET EXPLORER 11 COMPATIBILITY ISSUES
COMPATIBILITY VIEW

Root Cause: If the browser is not FF or IE10, it always opens another window to check
JRE.

Resolution: Do not open the JRE check window when using IE11.

9312_333
Bug ID 24450675: PRICE EFFECTIVE DATE REDUCED ONE DAY DURING IMPORT

Root Cause: 1. Some inactive rows are not filtered out. 2. The pagination logic is
incorrect.

Resolution: 1. Filter out inactive rows. 2. Correct the pagination logic.

PLM Release 9.3.2.0

This section includes Hot Fixes included in Agile PLM 9.3.2.0.

9320_197

Bug ID 21848388: USING SET AS BEST, PCM COST CALCULATION IS WRONG IN
ASSEMBLY COST REPORT AND ECR

Root Cause: The Material Price Adder attributes are not passed as needed, so it does
not include them in the Total Extended Price.

Resolution: Invoke related method with Material Price Adder attributes.

9320_202

Bug ID 22258772: LEGACY BOM COMPARISON REPORT DOES NOT DETECT
DIFFERENCES IN FIND NUM

Root Cause: The code uses HashSet to store mfrParts, but multiple Items may have the
same mfrParts, which can cause the pricelines read though from mfrParts to get lost
for some Items.

Resolution: Use ArrayList to store mfrParts.

9320_203

Bug ID 22078398: EXTERNAL ROLLUP (BATCH AND AD-HOC) NOT RETURNING
SUBSTANCES IF BOM

Root Cause: When one of the BOM parts’ quantity is set to 0, there is a substance
whose calculated mass is 0 in table result_substance_compliance. When getting
validate substance, total count (include 0) and valid count (nono-zero) in table result_
substance_compliance does not match. Therefore, no substance is returned.

Resolution: Made the valid count include 0 substance.
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PLM Release 9.3.2.0

9320_206

9320_209

9320_212

9320 214

9320 217

9320_218

Bug ID 22619898: AGILE 934 AUDIT STATUS PROVIDING INCONSISTENT
RESULTS

Root Cause: When a user opens an Item with a certain rev, the rev information is
stored in user context. When the user then opens a Change object to do an audit, some
priv checks are done for Affected Items using the rev information stored in user
context. The mismatch between rev stored in user context and Affected Item object
causes the problem.If there is criteria related to rev or rev attributes the priv check
returns the wrong result.

Resolution: Reset rev for correct Al's which is being dealt with run time, and set the
original rev back to context after the required fields check is finished.

Bug ID 22979199: DYNAMIC LIST WITH CRITERIA SET FOR SUPPLIERS SHOW
SUPPLIER NAME IN WEB CLIENT

Root Cause: Get supplier name from cache.

Resolution: Get display name from cache when displaying supplier.

Bug ID 22817641: NO MORE DATA TO READ FROM SOCKET ERROR WHILE
RELEASING DECLARATION

Root Cause: When updating REV flags according to (Item, Change) key-value record
selecting from SUBSTANCE_MAP, there are thousands of duplicate (Item, Change)
appearing after IN clause.

Resolution: Filter duplicate records using GROUP BY OBJECT_ID, OBJECT_
CHANGE.

Bug ID 24336433: SELECT ITEM FOR THE REPORT WINDOW SHOWS BLANK
REVISON FOR BOM COMPARISON REPORT

Root Cause: If the user disables the license of PGC model and goes to the report
wizard, the add by search window is deployed with fewer columns than usual, and it
brings a mismatch at the code level.

Resolution: Get the right column value of Revision.

Bug ID 24564717: PORTFOLIO DELIVERABLE GATE REPORT - ROWS MISSING IN
TABLE INSUFFICIENT

Root Cause: Missing row is counted correctly.

Resolution: Change the code in regards to how the row is counted.

Bug ID 23588916: AGILE PPM - CONTENT TAB, EDIT RULE ERROR
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PLM Release 9.3.3.0

9320_219

9320_220

Root Cause: If the Activities.Content.RelatedTo field is not in the Applied To list of the
Read Programs privilege, it generates a nullpointerexception as there is no null check.

Resolution: Handled the Null.

Bug ID 24713366: MAXIMUM NUMBER OF EXPRESSIONS IN A LIST IS 1000

Root Cause: This is caused by an Oracle DM limitation. The key word 'in’ in the
PL/SLQL statement only can add 1000 parameters.

Resolution: If the list is beyond 1000, correct the PL/SQL statement so that there is no
limitation like '(table.column,0) in ((1,0),(2,0)...)".

Bug ID 24842691: UNABLE TO SAVE "CORRECT UNKNOWN SUBSTANCES" ON
HOMOGENEOUS MATERIAL

Root Cause: The key word 'in' in a PL/SQL statement only can add 1000 parameters
due to an Oracle database limitation. The number of rows that are going to be
corrected are more than 1000 in table SUBSTANCE_MAP. An exception is thrown.

Resolution: If the list is beyond 1000, correct the PL/SQL statement so that there is no
limitation like '(rowID,0) in ((1,0),(2,0)...)".

PLM Release 9.3.3.0

9330_303

9330_305

9330_313

2-4 Agile Product

This section includes Hot Fixes included in Agile PLM 9.3.3.0.

Bug ID 21641482: ADVANCED SEARCH DISUCSSION OBJECT RELATED TO IS
NOT WORKING AS EXPECTED

Root Cause: If there is a value in the Discussion's related to attribute, the data should
exist in view 'DISCUSSION_RELATED_TO', but it loses RFQ object.

Resolution: Union all the data in RFQ object.

Bug ID 21760176: "MORE->FULL DISPLAY MODE" IS GRAYED OUT FOR THE USER
WITHOUT MODIFY ITEM PRIVILEGE

Root Cause: The Full display mode needs Edit privilege on Change.Affected Item.Title
Block.

Resolution: Removed the privilege check.

Bug ID 22063346: CANNOT INACTIVATE/DELETE CONTACT USER OF SUPPLIER
Root Cause: Code defect, no subclass id when check discovery privilege.

Resolution: Add subclass id when check discovery privilege.

Lifecycle Management Readme
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9330_314

9330_317

9330_318

9330_319

9330_321

9330_322

Bug ID 21756864: ITEM HISTORY GROWING DUE TO IMPORT

Root Cause: When Change Items's new revision in ECO'S Al, system will re-get the
value from DB and change the numeric flex attributes's value to double, the system
compares the new value with the old value in String.

Resolution: When comparing the numeric attribute's value, remove the last '0' and "'

Bug ID 21950348: PARTNER DETAILS ARE NOT APPEARING CORRECTLY ON THE
SOURCING PROJECT

Root Cause: The system currently loads all partners for the child component if
rendering Parts in UL

Resolution: Only load the partners created for the child component if rendering Part in
UL

Bug ID 22098118: CAN NOT ADD USER GROUP TO ESCALATION TAB OF USER
GROUP IN WEB CLIENT

Root Cause: The UserGroup option hasn't been configured to be displayed, and special
strings in notified user value hasn't be properly handled.

Resolution: Turn the display config of UserGroup on and add new method to handle
special strings in notified user value.

Bug ID 21982192: MAXIMUM NUMBER OF EXPRESSIONS IN A LIST IS 1000

Root Cause: This is caused by an Oracle database limitation. The key word 'in' in the
PL/SQL statement only can add 1000 parameters.

Resolution: If the list is beyond 1000, correct the PL/SQL statement that there is no
limitation like '(table.column,0) in ((1,0),(2,0)...)".

Bug ID 22078422: EXCEL IS CRASHING WHILE EXPORTING REPORT
Root Cause: The Report Export function treats HTML as EXCEL for output data.

Resolution: Fixed issues.

Bug ID 21768570: BREAKS PART GROUPS > COMMODITY SEARCH VIA WEB
CLIENT IN SDK

Root Cause: For Part Family, it does not have a default sort column, however,
HF933.180 uses the sort column ID for all kinds of objects and exposes this issue.

Resolution:

1. Filter 0 case in HF180 functional code.
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9330_323

9330_325

9330_326

9330_328

9330_329

2-6 Agile Product

2. Add a default sort column for PartFamily. Actually, a default sort column exists in
the Ul and it displays sort by name, however, it does not work now. This fix will make
it work.

Bug ID 22065657: UNABLE TO IMPORT SUPPLIER COMMODITY OFFERINGS

Root Cause: Import attempts to use the Commodity name, Ship To and Rating as the
unique key of one Supplier Commodity Offering row when it tries to determine the
import operation(Update existing row or Create a new Row).

Resolution: Use the Commodity name and Ship To as the unique key of one Supplier
Commodity Offering row

Bug ID 22170859: GETCELL() FOR APl NAME RENAMED PAGE THREE
ATTRIBUTE ENDS IN NULLPOINTER

Root Cause: This is because the current attribute key for the subclass level is not
unique in the cache.

Resolution: Added subclass id as part of the key to distinguish the different attribute.

Bug ID 22265593: SDK IMPORT FAILED WITH ERROR

Root Cause: The api-ejb.jar used in the following two paths and current hf installer
template only replace #1 path, depending on the environment, the server may load the
class from either #1 or #2. This can cause an issue if the classloader loads that file from
path2 . This also explains why it works in the QA environment at load path #1.

Path 1: application.ear/ api-ejb.jar
Path 2: application.ear/ APP-INF/lib/api-ejb.jar

Resolution: Change the hf installer template to replace both paths. Also, check in to
clearcase that all future hot fixes will use this latest template.

Bug ID 22199750: SPECIAL CHARACTERS IN NOTIFICATIONS AND COMMENTS
ARE BEING REPLACED

Root Cause: When going back to the Comments page, the value of comments is
encoded twice.

Resolution: Encode only one time.

Related Bug 22121771: SPECIAL CHARACTERS IN NOTIFICATIONS AND
COMMENTS ARE BEING REPLACED

Bug ID 22115775: UNABLE TO RUN CHANGE PACKAGE REPORT FOR SOME
PARTICULAR ECOS
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9330_336
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Root Cause: Dead loop to make heap warning when there is a very large amount of
text in report headers. It should cover more cases even when it has a specific BOM
value.

Resolution: Split the content to jump out of the dead loop to make sure the report runs
successfully.

Bug ID 22185883: IMPROPER VALIDATION WHILE IMPORTING OBJECTS TO
AGILE 933

Root Cause: The warning msg was changed to not include object number in 933.

Resolution: Check whether autonumber is used before deciding whether the warning
msg should include the object number info or not.

Bug ID 20681846: UNABLE TO SAVE AS PROJECT (IPROGRAM) USING AGILE SDK
Root Cause: The behavior of SDK is different from that in the UL

Resolution: Added a new method also named saveAs() by adding a new boolean
parameter, createFromTemplate, to distinguish whether it is created from saveAs or
created from template.

Bug ID 22159320: DATA IN MULTITEXT FIELDS DO NOT CARRYOVER ON THE
NEW REV

Root Cause: When adding a newly created Change Order or doing a Save As on an
Item, it does not insert the related row to the agile_flex table if multiText]l and
multiText2 values exist.

Resolution: If the value of the multiTextl and multiText2 fields are there, it adds the
records to the agile_flex table accordingly when doing a Save As on an Item or creating
a Change on it.

Bug ID 21660318: INCORRECT COMPLIANCE VALUE CALCULATION ON BOM

Root Cause: While rolling up the BOM structure if the Deviation released is base on
the latest ECO and the released Date < the released Date of some leaf BOM children,
the rollup result might be incorrect. The released date of deviation will be treated as
the cut off date so those leaf boms released later will be missed.

Resolution: If the latest rev is deviation/stop shop/ECR based on the latest released
ECO/MCO the cut off date would be a hard code date in the future so all leaf children
are counted in.

Bug ID 22004887: UNABLE TO SEE ATTACHMENTS WHEN ACCESSED FROM
WHEREUSED TAB OF ANOTHER

Root Cause: Did not get the correct default change class id for the Where Used object.
Resolution: Get the correct default change class id for the Where Used object.
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Bug ID 22150906: EXPORTED RESULTS HAS INFORMATION OF ATTACHMENTS
FOR INTROD. REV AND NOT LATEST

Root Cause: Export from search always exports the introductory rev.

Resolution: Export the rev in the search result.

Bug ID 21878301: ISSUES IN IE, PATCH 21118501 (9.3.3.0.256) WAS APPLIED FOR
IE11 COMPATABILITY

Root Cause: IE specific issue. CSS property position of auto-complete suggestion is
absolute, and the position of its ancestors is static until the HTML document.

Resolution: Set the position of PageViewContent to relative from static.

Bug ID 22280112: CONTENT RULE FAILING FOR PROJECT CREATED FROM
TEMPLATE AND MULTIPLE RULES SET

Root Cause: When building subscription info, the retrieved subscriber id is equal to
publisher id from the hashmap, which makes the function not work.

Resolution: When building subscription info, if retrieved subscriber id is equal to
publisher id, we need to get the publisher id through the subscriber id instead of
getting subscriber id through publisher id from hashmap.

Bug ID 22316859: TAKING HUGE TIME WHILE LOADING WORKFLOW ROUTING
TAB ON HOMEPAGE

Root Cause: Running some SQL takes too much time.

Resolution: Create a composite index on the target table.

Bug ID 22180711: ITEM ATTACHMENT TAB FOLDER DESCRIPTION FIELD
LENGTH CANNOT BE MODIFIED

Root Cause: Max length of Attachment.FolderDescription is smaller than
FileFolder.Titleblock.Description and it cannot be modified, so the description will be
truncated when the row is built.

Resolution: First make the Attachment.FolderDescription.MaxLength modifiable.
Then deal with inconsistency between Attachment.FolderDescription.MaxLength and
FileFolder.Titleblock.Description.MaxLength. Truncate the description if the former is
smaller than the latter, or stop the user from saving as well as showing the error
message in the opposite case.

Bug ID 21967777: BOM EXPLOSION REPORT FAILED WITH 'SOME ONE
WORKING ON THIS OBJECT” ERROR
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Root Cause: It is to acquire report object lock when logging report execution history.
Multiple threads are executing the same report at the same time, so only one thread
can acquire the lock at a time, other threads fail with "some one working on the
object".

Resolution: Remove the acquire report object lock when logging report execution
history.

Bug ID 22111632: SCROLL BAR AND UPDATE BUTTON MISSING IN MORE | |
VIEW LATEST CURRENCY RATES

Root Cause: Using incorrect CSS on div layer so that the scroll bar is hidden.

Resolution: Use proper CSS on div layer when viewing conversion rates.

Bug ID 22447281: DEFAULT ACTIVITIES WORKFLOW DOES NOT ALWAYS
TRIGGER EMAIL NOTIFICATION

Root Cause: When editing Schedule Date/Percentage in the Cover Page of a Project
object, the default notifiers are not retrieved.

Resolution: Retrieve the default notifiers when editing Schedule Date/Percentage in
the Cover Page of a Project object and set them to the nofity list.

Bug ID 22367423: ONE OFF REQUEST FOR 22147646: SERVER HANG AND OOM
CONDITION

Root Cause: There is a huge history of data in the customer’s environment. The
attribute, Transaction ID(s), has a huge amount of data and the change to this attribute
is triggering a huge entry into history. The size of one history record data is about
200KB.

Resolution: Add a new property, export.maxHistoryDetailsLength, into the properties
file, and only if export.maxHistoryDetailsLength is set to a value that is bigger than 0
,export will truncate the value of history details.

Bug ID 22345551: ERROR FAILED TO GET PROPERY AFTER INSTALLING PATCH
9.3.3.0.310

Root Cause: the date format for PrintDate was hard-coded. Also all date attributes
were not formatted to the user date format.

Resolution: Used a a user date format for PrintDate and for all attributes of Date type.

Bug ID 22487429: GETFILENAME USED IN PX DURING CHECKIN DOES NOT
Root Cause: All file names are the first file name.

Resolution: Get all files name correctly.
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9330_364

Bug ID 22509103: DRAG AND DROP ITEM ON UPDATE TABLE EVENT FAILING
EVEN WITH 9.3.3.0

Root Cause: The change key object ID can be -1. This is not a valid object ID, but it is
not caught and handled properly in EventDirtyRowUpdate#getReferent().

Resolution: If the change key object ID is -1, then set the change object key to null.

Bug ID 22492951: CHANGE STATUS EVENT INFO IS NOT PROVIDING THE
CURRENT APPROVERS PROPERLY

Root Cause: If the user sets auto-prompt as yes, and adds approvers in Web Client,
Agile cannot fetch the users updated in Web Client. It only gets the users from
Template.

Resolution: If there is any user updated in Web Client, catch it using method
getReviewersByStatusID().

Bug ID 22563487: JAPANESE FILE NAME IN DOWNLOAD.ZIP IS CORRUPTED
Root Cause: This is caused by an Agile ZIP util bug.
Resolution: Use JDK API to create a ZIP file.

Related Bug: 23037147: JAPANESE FILE NAME IN DOWNLOAD.ZIP IS
CORRUPTED

Bug ID 22636323: PATCH 9.3.3.0.255 CAUSING APPLICTION ERROR WHILE
MOVING WORKFLOW

Root Cause: This issue is caused by a code defect that was introduced by bug 21118850.

Resolution: Used proper approach to handle the case when the class type is changed.

Bug ID 22651310: AFTER APPLYING 9.3.3.0.258 LIFECYCLE PHASE ERRORS OUT:
JAPANESE ENVIRONMENT XLSX IMPORT

Root Cause: The is a Japanese language specific issue. The xml data file of xIsx file may
contains 'TPh' element, and 'rPh' shows pronunciation of the data text. The data text
inside it should not be extracted

Resolution: Does not extract data inside the 'rPh' element.

Bug ID 22366692: EXPORTING OF SEARCH RESULT IGNORES THE SCALE OF
NUMERIC ATTRIBUTES

Root Cause: The code does not handle the decimal scale while exporting the search
result.

Resolution: Add the code to handle this.
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9330_368

9330_371

9330_372

9330 374

9330_376

Bug ID 22921798: OWNER OF PROJECT DOES NOT GET ACTIVITIES -
PREDECESSOR PROJECT SCHEDULE NOTIFICATION

Root Cause: When activity P1 is required for P2, and P1 and P2 have different root
parents, P2 is not notified when P1's schedule is changed. Notification of external
dependencies are not included.

Resolution: When sending notification, it should notify those activities which are
dependent upon this activity - both internal and external dependencies.

Bug ID 22921798: TASK CONFIGURATION FOR 'SCHEDULE EVENT TASK' IS NOT
WORKING IN CLUSTER

Root Cause: In a cluster situation, node 1 had a scheduled event that was executed for
much longer than 5 minutes. The task in one node was started after the scheduled task
started in 1 node. The secondary node did not know if the first node already started a
scheduled event.

Resolution: Added a column, server_node_name, in scheduled_event_tracking, to
store the node name in this column. Then we can identity which task runs which node.

Bug ID 22900862: IE 11, EXTRA PAGE

Root Cause: If the browser is not FF or IE10, it will always open another window to
check JRE.

Resolution: Skip the opening of the window to do the JRE check when using IE11.

Bug ID 22963448: SIZE ATTRIBUTE(ITEM.DOCSIZE) IS NULL WHEN EXPORTING
Root Cause: Always use Parts.Title Block.Size attribute info to resolve list value.

Resolution: If the object class is Document, then use Document.Title Block.Size
attribute info to resolve the list value.

Bug ID 22854267: AXML EXPORT OF DEVIATION PROVIDES INCORRECT
REVISION INFORMATION FOR ITEM

Root Cause: When the user attempts to set the release date of the introductory rev to
01-01-1900 to make its release date earlier than any change date, the release date is set
to current date due because the Calendar is used incorrectly.

Resolution: Adjust the code to set the release date of the introductory rev to
01-01-1900.

Bug ID 23064272: DFEM - ADD/GET FILE ATTACHMENTS TAKE 16-18SEC WHILE
ON IFS ONLY A FEW SEC

Root Cause: Two factors:
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1. Pinging DFM costs a lot of time.

2. When replicating, the check to see if file exists WS call also costs a lot of time.
Resolution:

1. Ping action correct to normal ping servlet approach.

2. Remove file exists WS call, instead of using get file size WS call.

Bug ID 22889506: JAVA PX ERROR DURING FILE UPLOAD IS NOT DISPLAYED IN
WEB CLIENT UI

Root Cause: Ul did not handle the error message from the Agile server.

Resolution: Display the error message and do not refresh the table.

Bug ID 22889469: CHECKIN JAVA PX ERROR DOES NOT REFLECT UPLOAD
STATUS ON FILE UPLOAD

Root Cause:
1. JavaScript does not correctly update the page after an exception is caught.

2. The sserver updates the DB table, HISTORY_FILE_UPLOAD, setting UPLOAD_
STATUS=1, before an exception is thrown. Additionally, there is no rollback action
after the exception is caught.

Resolution: 1. Set the error message in the callback function of the check in action in
JavaScript.

2. Rollback the DB entry after folder check-in fails.

Bug ID 23077369: ERROR ADDING NEW ATTRIBUTE DURING ACP IMPORT

Root Cause: On the server side, an exception is thrown when inserting records to
langtable with multiple languages enabled when using ACP import.

Resolution: Handle this special exception when importing attributes with ACP.

Bug ID 23080898: NOT GETTING POP UP WHEN FORGOT TO SAVE REDLINE
CHANGES IN FULL DISPLAY MODE

Root Cause: The code does not do an unsaved change check while navigating via
backward/forward arrow in full display mode.

Resolution: Added unsaved change check.

Bug ID 22889496: CHECKOUT EVENT ON MULTIPLE FILES NOT RETURNING
CORRECT ITEM REVISION

Root Cause: The application does not get rev info from the UI. When an Event object is
built, it is passed null as rev.
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9330_390

9330_391

9330_393

9330_394

Resolution: Get the Item rev from the UI. Build the Event object with Change ID and
Change class.

Bug ID 23124702: SQL USED TO SETUP THUMBNAIL MAXES DB SERVER CPU

Root Cause: Thumbnails are set up even though thumbnails are disabled. Thumbnail
setup SQL is bad.

Resolution: Do not setup thumbnail when it is disabled and correct SQL.

Bug ID 23134768: LONG CHINESE FILENAME SHOWS LFDOWNLOADSERVLET
WHEN TO DOWNLOAD

Root Cause: The method, MimeUftility.encodeText(), folds the text if the length is too
long.

Resolution: Replace folded string, \r, \n with empty.

Bug ID 23122375: FILELOAD DOES NOT WORK AFTER INSTALLING PATCH
9.3.3.30 USING WEB CLIENT

Root Cause: The system does not correct handle the Linux file path with '/". After
933.30 it gets an invalid character error when doing an upload on Linux client.

Resolution: Get the file name and ignore '/' to support file load on Linux.

Bug ID 23013844: ERROR WHEN CHANGING LIFECYCLE BY FILL DOWN OPTION
UNDER A CHANGE

Root Cause: Fill down/up in Ul only uses the attribute id of the selected LCP cell to
set rows below /above. The id of the LCP may not be in the other classes.

Resolution: Added LCP check for fill down/up LCP cell case. If class does not have
the LCP with the replace id value, but has the same name LCP, the system will use the
same name LCP in this class to do the replace.

Bug ID 23274677: SEARCH PPM OBJECT FAILED WITH ERROR: FAIL TO CONVERT
TO INTERNAL REPRESENTATION

Root Cause: The Root Parent attribute is added into the select clause for privilege
checking. This attribute requires adding three more columns (id, class, subclass).
Therefore, this issue is caused by fetching the wrong column value as added three
more columns in select clause.

Resolution: Handle the root parent from privilege checking the same as the one to be
output column.
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Bug ID 23343504: ISSUE WITH GET FILE ATTACHMENT WITH
HTTPS:/ /CONNECTION

Root Cause: Download servlet cannot get the correct url when doing forward. So it use
request URL to redirect request. but sometimes request URI is different with user
preferred File Manager URL. It causes the download to fail.

Resolution: Put user preferred URL in request parameters instead of request URL.

Bug ID 23483391: POP UP DOES NOT APPEAR WHEN USER FORGETS TO SAVE
REDLINE CHANGES IN FULL DISPLAY MODE

Root Cause: The code does not do an unsaved change check while navigating via
backward/forward arrow in full display mode.

Resolution: Added unsaved change check.

Bug ID 23520126: AGILE IMPORT ISSUE WITH MULTI LIST ATTRIBUTES

Root Cause: When the aXML file contains flexible attributes, the XML node of the
multilist attribute inside the source file is treated as non-multilist.

Resolution: Correct the logic of determining whether or not an XML node inside the
source file is a multilist.

Bug ID 23623043: AGILE CLASSES REPORT SHOW BLANK FOR NUMERIC
ATTRIBUTE MIN VALUE WITH MINUS VALUE

Root Cause: When typing in a negative value for MIN VALUE, after loading data,
Agile compares MIN VALUE with Double. MIN_VALUE when Double. MIN_VALUE is
between 0 and 1 and negative value is less than Double. MIN_VALUE. The value is
consequently set to empty.

Resolution: Compare MIN Value with - Double. MAX_VALUE instead of Double. MIN_
VALUE.

Bug ID 23573090: USER ABLE TO IMPORT EXT GROUPS TO ITEM USERGROUP
ACCESS-INTERNAL FIELD

Root Cause: Before import, illegal values that do not meet the criteria have not been
ruled out.

Resolution: First select the result lists based on criteria, and then check if the
user-given value is in the list.

Bug ID 23645490: UNABLE TO RETRIEVE 'JOB FUNCTION' COLUMN VALUE
FROM 'FUNCTIONAL TEAM
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Root Cause: Functional Teams.Job Function(s) is a multilist attribute, but its value was
constructed as a text attribute.

Resolution: Construct a multilist value for the Functional Teams.Job Function(s) while
loading from database.

Bug ID 24351704: *NULL VALUES BEING DISPLAYED WHEN LARGE NUMBERS
OF USERS ASSIGNED

Root Cause: Wrong type is passed when retrieving user data.

Resolution: Explicitly pass the correct type, rather than getting from attribute.

Bug ID 24292326: LIST TYPE ATTRUBUTE OF FEW LIST HAVE CHANGED TO
SEARCH

Root Cause: When list record size is greater than Maximum List Values Displayed set
on the admin side, Agile switches the Ul control from list to search, as well as the
display type of the list in the cache.

Resolution: Block auto switch from U, especially on titleblock, grid table and search.
Enable to manually change and save display type via Java Client.

Bug ID 24358717 FUNCTIONAL TEAM QUERY NOT GIVING CONSISTENT
RESULTS BETWEEN WEB CLIENT

Root Cause: SDK query only gets some of the available values for the User Group list
and then compares these values with the search condition.

Resolution: Changed the logic to get all available values for the User Group list and
then compare these values with the search condition.

Bug ID 24374300: NOT ABLE TO OPEN THE ACTION ITEM FROM REVIEW OBJECT

" "

Root Cause: There is no special handler for the "' and

Ttem.

in the subject of an Action

Resolution: Added a special handler for " and " in the subject of an Action Item.

Bug ID 24305162: LIST TYPE ATTRIBUTE OF FEW LIST HAVE CHANGED TO
SEARCH

Root Cause: When the list record size is greater than Maximum List Values Displayed
set on the admin side, Agile switches the UI control from list to search, as well as the
display type of the list in the cache.

Resolution: Block auto switch from U, especially on titleblock, grid table and search.
Enable the ability to manually change and save display type via Java Client.
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Bug ID 24461182: THUMBNAILS DO NOT GET GENERATED

Root Cause: If some cookies have a null value, it blocks the thumbnail server
authentication.

Resolution: Filter out all null value cookies when doing authentication.

Bug ID 24467424: SEARCH ISSUE WHEN LARGE NUMBER OF USERS ARE
ASSIGNED TO JOB FUNCTION

Root Cause: The Functional Team has its own table that is not stored in the User Group
table.

Resolution: Get correct database table for Functional Team

Bug ID 24500659: CHANGE.AFFECTEDITEM.MULTILIST02 BEHAVES DIFFERENT
THAN MULTILIST10

Root Cause: The max length of PAGETWO.MULTILISTO1(MULTILIST02 and
MULTILISTO3 are the same) is 255 bytes. Those whose length is more than 255 are cut
to 255 and are saved into table PageTwo.

Resolution: If the string length is more than 255, set ",-1," to multilist01 in table
PageTwo. When getting the value of attribute multilist01, load the full result from table
MSATT.

Bug ID 24592795: NODE (18022 , 2480887) DOES NOT EXIST IN THE CACHE ERROR
WHEN CREATING SUBCLASS

Root Cause: When checkinf the P3 flexible attribute of a newly created subclass, the
subclass id is not passed.

Resolution: Pass the subclass id when checking the P3 flexible attribute of the newly
created subclass.

Bug ID 24564941: ADVANCE SEARCH REPORTS DELETED OBJECT IN DYNAMIC
LIST AS NO PRIVILEGE

Root Cause: When an object is soft-deleted or hard-deleted, the multilist value
referencing this object is not deleted in the database side. In the query result, the server
side does not return any value if the current object is in the delete state.

Resolution: When an object is soft-deleted or hard-deleted, the server-side check
references the object delete status before adding its value into the query result.

Bug ID 24602367: SEARCH ISSUE WHEN LARGE NUMBER OF USERS ARE
ASSIGNED TO JOB FUNCTION

Root Cause: Functional Team has its own table, not stored in the User Group table.
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Resolution: Get the correct database table for the functional team.

Bug ID 24651232: WHERE USED TAB OF FUNCTIONAL TEAM NOT LOADING
Root Cause: The SQL to get whereused is not correct.

Resolution: Tuned the bad SQL.

Bug ID 24702136: SYSTEM RETURNS JAVA.LANG.NULLPOINTEREXCEPTION
WHILE CHANGING TASK STATUS IN PPM

Root Cause: A user who made some changes on workflow has been deleted
permanently. Then when changing the status and loading the workflow table, the
deleted user can NOT be found and null pointer exception is thrown.

Resolution: Handle the nulllpointer exception.

Bug ID 24675460: IN IE11 DOCUMENT MODE IS NOT FORCED TO
Root Cause: Browser detection fails when running in IE11.

Resolution: Force IE to go to the IE7 document mode and resolve the found bugs.

Bug ID 24694426: SDK RETURNS WRONG COUNT OF SUBSTANCES IN MFR PART.

Root Cause: The loading flag in user context is not reset before invoking the Event
script PX.

Resolution: Reset the loading flag to load all substances.

Bug ID 24933696: ECR/DEVIATION REV COLUMN ISSUE.

Root Cause: Class has not been checked before class casting, which leads to a
ClassCastException.

Resolution: Check class before casting.

Bug ID 24785838: ERROR CODE: 985 OCCURS AFTER CHANGING THE SDK USER
FROM SYSTEM USER

Root Cause: Agile generates a session ID for a WebLogic LDAP authenticated user by
the user principal signature, so the session ID is not unique if it invokes a WSX service
concurrently with the same LDAP user account. All the WSX invocations share the
same session. If one of the WSX invocation finishes, it logs out the user and terminates
the session, then the incomplete web service invocation will have a Null Point error.

Resolution: Generate a unique session ID for each invocation of WSX service.
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9330_435

Bug ID 24464004: UPCOMING ACTIVITIES AND ACTION ITEMS ARE NOT
LOADING

Root Cause: TheTableComparator's compare method is not transitive. When
comparing date, null value is treated as equal to any other date, but this is not
reasonable. An exception may be thrown when using it to sort.

Resolution: Fix the compare method. The Null value will be larger than any other date.

9330_436

Bug ID 24464382: FUNCTIONAL TEAM DETAILS DISPLAYED WRONGLY ON USER
PROFILE

Root Cause: The function team of a user displays more FI when responding job
functions have many users that exceed maximum multiple list entry length. The server
has the wrong codes to fetch FT data.

Resolution: Correct the codes to get correct FT data.

9330_437

Bug ID 24952656: DYNAMIC LIST WITH CRITERIA SET FOR SUPPLIERS SHOW
SUPPLIER NAME IN WEB CLIENT

Root Cause: Application currently gets the Supplier Name from the cache.

Resolution: Get Supplier display name from cache when displaying QCR.

9330_439

Bug ID 24843233: NEEDS 9.3.3.0.170; HAS A CONFLICT BETWEEN 9.3.3.0.67 &
9.3.3.0.125.

Root Cause: Browser detection fails when running in IE11.

Resolution: Force IE to go to the IE7 document mode and resolve the bugs.

9330_441

Bug ID 24956464: ADD AN ITEM IN THE RELATIONSHIP OF ANOTHER ITEM VIA
SDK API AND JSP

Root Cause: The incorrect object is used to register the event.

Resolution: Set the correct object ID.

9330_444
Bug ID 25037483: CANNOT ADD ANY BOM COMPONENT TO ITEM

Root Cause: The length of collection t_varchar2s defined at the system level is 32.
When an object number is larger than 32, doing external rollup throws a numeric or
value error exception.

Resolution: Exceed length of t_varchar2s to 300.

9330_447
Bug ID 22708010: API ALLOWS ASSIGNING INACTIVE LIST VALUE TO LIST
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Root Cause: This is caused by a list attribute validation defect in SDK if a CascadeList
is used during setvalue.

Resolution: Additional validation was added to throw an error if an attempt is made
to set an inactive list entry value to an attribute.

PLM Release 9.3.4

9340 _48

9340_49

9340_52

9340_56

9340_58

This section includes Hot Fixes included in Agile PLM 9.4.0.

Bug ID 21645895: EC ATTACHMENTS, PDF, VIEWABLES

Root Cause: In 934, EC does not process the configuration of PublishAttachments in
CAXConfig.xml. The correct logic will only have these viewable files when publishing
the files to the Item’s Attachment table if the customer configure it.

Resolution: Make sure that the viewable files is published to Item correctly if the
customer configures PublishAttachments in CAXConfig.xml

Bug ID 21779707: ITEM DATA IS MISSING IN ACS OUTPUT FILE
Root Cause: The loop index to process batch is not increased correctly.

Resolution: Correct the loop index.

Bug ID 21908877: LENGTH OF URL FIELD IN REFERENCE_OBJECT TABLE IS TOO
SMALL

Root Cause: The size of URL column of table REFERENCE_OBJECT is small (255
char).

Resolution: Change the size of URL column of table REFERENCE_OBJECT to 2000
characters.

Bug ID 21902250: PASTING TEXT INTO LARGE TEXT FIELD REMOVES
FORMATTING

Root Cause: If the user copies text from Editor, for example, Windows Notepad or
Notepad++, to LargeText editor, line breaks generate html tag </br>, but </br> is not
allowed.

Resolution: Allow html tag </br>.

Bug ID 21977627: AGILE CONFIGURATION AND PROPAGATION DOES NOT
IMPORT NOTIFICATIONS

Root Cause: This is caused when the ACP import’s target A9 system does not exist and
the customized notification, which was created in the source A9 system, does the
updating after creation, but it cannot get the ID, so it throws the nullpoint exception.
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9340_66

9340_69

9340_72

9340_73

Resolution: If the target A9 system does not exist the customized notification (which
was created in the source A9 system), just create it, because there is no need to do the
update. Update is only used for an existing object.

Bug ID 22021795: THE MULTI-TEXT FIELDS WRAP THE TEXT IN THE MIDDLE OF
A WORD.

Root Cause: word-break: break-all; This CSS property breaks word.
Resolution: Remove this CSS property: word-break: break-all;

Bug ID 22052448: UNABLE TO BLANK OUT NUMERIC ATTRIBUTE FIELDS

Root Cause: If the numeric field is blanked out, the code to parse the entered value
returns a NULL Number object. Getting the double value by Number.doubleValue
throws a NULL pointer exception.

Resolution: Rewrite the logic to compare entered value and old value.

Bug ID 22128958: 9.3.4 IS LOOKING AT THE CHANGE AS A WHOLE

Root Cause: We only check privilege on class level and do not do the subclass level
check.

Resolution: Involved subclass id verification when checking Required fields.

Bug ID 22095842: CANNOT RUN IMPORT FROM THE AGILE CLIENT WITH
NON-EXISTING PARTS IN AGILE 9.3.4

Root Cause: This is a nullpoint issue, because the Part that is imported in the aXML file
does not exist in the system, so it throws the error.

Resolution: When doing the import, first determine if the Part exists. If it exists, the
code will go on, otherwise skip.

Bug ID 22033395: VISIT AGILE PLM SERVER BY IP ADDRESS, CANNOT UPLOAD
FILE

Root Cause: Only a URL entered into Java Client's Web Server URL can be used to do
file upload. This is used to check the origin of request that can be allowed to access file
server for uploading from web client. The IP address of the server will also be treated
as an unaccepted URL.

Resolution: We provided configuration in the file server's server.conf for extra access
URLS so that File server considers those URLs as valid "Access-Control-Allow-Origin".
After the installation of each file server, add those extra Agile access URLSs to the
configuration parameter "extra.allowedorigin.appurl”, and separated by ";". This
solution can also be used for proxy servers.
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Bug ID 22308397: UNABLE TO SAVE FILES FROM MCAD CONNECTOR INTO
AGILE

Root Cause: There is an NPE if the subclass part is deleted. It is caused by the code to
check the whether the attributes (part > relationship > text01, part > relationship >
text02, design > relationship > text01, design > relationship > text02) enabled or not in
the subclass level.

Resolution: If the subclass part is deleted, omit the checks to avoid the NPE that causes
the issue.

Bug ID 22293199: WRONG FORMAT FOR NUMERIC FIELD IN AXML OUTPUT FOR
FRENCH LANGUAGE

Root Cause: The French system's number format is different form standard English.

Resolution: Convert the number format to English format.

Bug ID 22234155: WORKFLOW EXIT REQUIRED FIELDS NOT ENFORCED

Root Cause: If an update is made to the attribute Relationship.name, the attribute id
changes and the original special handler misses it.

Resolution: Got the base id of the attribute and made the handler make sense.

Bug ID 22288264: THE STATUS OF LOCAL FILE SHOULD BE SYNCED TO AGILE
EVEN THE USED

Root Cause: There is NPE when the user selects the row that is associated with the
specified Item in the Save Preview window. This is caused by getting the cascade list
data that value is removed or nonexistent.

Resolution: Make sure the NPE is resolved and can get the correct Item and version
information when the row is selected in the Save Preview window.

Bug ID 22478088: SEARCH RESULT EXPORT CONVERTED INTO USER'S LOCAL
TIMEZONE

Root Cause: For Activity common attributes, it does not show date time as configured
in Java Client when exporting.

Resolution: For Activity common attributes, only show the date if date only, not date
and time.

Bug ID 22465085: AGILE 934 AUDIT STATUS PROVIDING INCONSISTENT
RESULTS

Root Cause:
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Case 1: The root cause is that when we open an Item with a certain rev, the rev
information is stored in the user context. When the user then opens a Change object to
do an audit some privilege checks are done for Affected Items using the rev
information stored in the user context. The mismatch between rev stored in user
context and the Affected Item object causes the problem. If there's criteria related to
rev or rev attributes the priv check returns wrong result.

Case 2: Once a user manually changes the tab name from 'Page Two' to 'Document
Info' a new hereditary node is created in the database for this subclass level table. The
fix of 934HF42 gets the subclass node by invoking some admin side API, but it returns
the wrong node which causes the problem.

Resolution:

Case 1: Reset the rev for the correct Al's which is being dealt with at run time. Set the
original rev back to context after the required fields check is finished.

Case 2: Check if the enabled tab id either equals to one of the enabled tables at subclass
level, or equals to any inherit id of the enabled tables at subclass levels.

Bug ID 22481579: SPECIAL CHARACTERS IN NOTIFICATIONS AND COMMENTS
ARE BEING REPLACE

Root Cause: When the user goes back to the Comments page, the value of comments is
encoded twice.

Resolution: Choose encoding one time

Related Bug: 22553818: SPECIAL CHARACTERS IN NOTIFICATIONS AND
COMMENTS ARE BEING REPLACED

Bug ID 22510989: APOSTROPHE IN MANUFACTURER PART NUMBER THROWS
ERROR

Root Cause: We do not use the correct approach to handle the Manufacturer Part
Number which contain the apostrophe in any position.

Resolution: Use the existing method TextUtility.parseEscapeSingleQuote to handle the
case correctly.

Bug ID 22373933: MANDATORY FIELD IS NOT ENFORCED IF DATA IS CHANGED
AT DIFFERENT PAGE/TAB

Root Cause: There are three tables on Items: Cover Page, Page Two, Page Three. When
redlining items, the required attribute is not checked if there is no attribute changed
within that table.

Resolution: Set the attribute isEdited to true in the three tables, even though there is no
attribute changed on these three tables.

Bug ID 22380646: UNZIP UPLOAD FAILS IF ZIP FILE CONTAINS FILE WITH
MULTIBYTE CHARACTERS
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Root Cause: This issue is caused by JDK and zip software issues. The zip file may not
be encoded properly in UTF-8.

Resolution: Try to unzip in Charset "Cp437". Refer to http://bugs.java.com/view_
bug.do?bug_id=4244499.

Bug ID 22506922: EXTERNAL USER ENCOUNTER APPLICATION ERROR WHILE
SIGNOFF WORKFLOW STATUS

Root Cause: If the approver does not have privilge to view the new status of a Change
this issue occurs. On the server side, an empty Cover Page table is returned, but we
still try to get the status attribute, so there is an out of bounds exception.

Resolution: Validate if the table contain any row data before getting an attribute from
it.

Bug ID 22450150: ACS OUTPUTS DATE IN FORMAT DATE & TIME REGARDLESS
OF THE ADMIN TYPE

Root Cause: The XML schema definition for date attribute value is xsd:dateTime, date
only value '2015-2-15' is invalid.

Resolution: Change the aXML schema definition to allow xsd:dateTime and xsd:date
for Agile date attribute value.

Bug ID 22550304: GANTT CHART SHOWS BLANK SCREEN AFTER SAVING

Root Cause: When the user saves the Gantt chart, there are 2 steps: 1. Update and,
refresh and expand all the leaf nodes, and 2. The Ul is set to editable.

The user can edit a few cells during the period - after updating before refreshing, after
expanding all, the user will be confused as changes are messed up.

Resolution: Set the UI to be not editable until the leaf nodes are refreshed and
expanded so that the terminal user can not edit cells during the process.

Bug ID 22600566: LONG CHINESE FILENAME SHOWS LEFDOWNLOADSERVLET
WHEN TO DOWNLOAD

Root Cause: Method MimeUtility.encodeText() folds the text if the length is too long.

Resolution: Replace fold string, \r, \n to empty

Related Bug: 22727241: AGILE 9.3.4 FILE DOWNLOAD ISSUES DUE TO INVALID
CHARACTERS

Bug ID 22674951: SQL USED TO SETUP THUMBNAIL MAX'ES DB SERVER CPU

Root Cause: Thumbnails are set up even though thumbnail is disabled. Thumbnail
setup SQL is bad.

Resolution: Do not setup thumbnail when it is disabled and avoid SQL tuning.
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Bug ID 22713023: DISCUSSION DATE/TIME IS NOT IN ORDER

Root Cause: The reply order should be in the timestamp sequence not by the id
sequence.

Resolution: Order the replies in timestamp sequence.

Bug ID 22729850: ERROR WHILE INVOKING .NET WEBSERVICE FROM PX

Root Cause: SDK has a custom hot deploy class loader which is used to deploy the
Process Extension (PX) JAR files. Inside the PX, JAXWS is used. While the PX is
triggered, the current thread context loader is not the SDK hot deploy class loader, so
the current thread can read some class files which are loaded by the SDK hot deploy
class loader.

Resolution: Set the SDK hot deploy class loader as thread context class loader while
executing a PX.

Bug ID 22761592: DUAL IDENTIFICATION REQUIRED FLAG FOR WORKFLOW
STEPS WHERE STATUS TYPE=RELEASED

Root Cause: When the user does a Save As/New release status of a workflow, the Dual
Identification Required property is not inserted into the node.

Resolution: Add this property to release status of workflow when doing a Save
As/New status.

Bug ID 22674235: AGILE 9.3.4 BOM REDLINES MISSING WHEN LAST RELEASED
CHANGE IS SCO

Root Cause: 1. The logic for checking whether the revision of the Affected Item added
to SCO is the latest rev is wrong. The current logic may use pending revision for
checking.

2. The redline deleted BOMs will be filtered out if the rev of Affected Item that is
added to SCO is not the latest revision.

Resolution: Correct the logic of the check to filter out the pending revision directly, and
do not filter out the redline deleted BOMs if the redline deleted action is done by the
root change itself.

Bug ID 22659501: WARNING MESSAGE WILL POP UP TWICE WHEN DRAGGING
MULTI-OBJECT WITH PENDING ECO

Root Cause: The EW js sends the handle request to the server again even if one
warning is handled already.

Resolution: If one warning is handled already, do not send handle request to server.
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Bug ID 22671630: WHEN SAVING AN OBJECT MORE THAN ONE MISSING
FIELDS, SHOWS "..YOU HAVE ONE ERROR"

Root Cause: This is caused by a code defect introduced by bug 19162231 and 21118850.

Resolution: Use the proper approach to handle the case if the class type is changed,
and show the right count of the errors size.

Bug ID 22379231: IE 11, EXTRA PAGE

Root Cause: If the browser is not FF or IE10, it will always open another window to
check JRE.

Resolution: Skip the open JRE check window when using IE11.

Bug ID 22846280: GANTT REFRESH TIME IS UNACCEPTABLE

Root Cause: It takes time to refresh the Gantt chart during the Save action; and the
Refresh action is introduced in 934 comparing with the previous version.

Resolution: Run the SQL script to correct the data type to be double for attribute
2000000100.

Bug ID 22887140: DRAG AND DROP ITEM ON UPDATE TABLE EVENT FAILING
EVEN WITH 9.3.3.0

Root Cause: The change key object ID could be *-1", This is not a valid object ID, but it
is not caught and handled properly in EventDirtyRowUpdate#tgetReferent().

Resolution: If the change key object ID is *-1’,then set the change object key to null.

Bug ID 22878739: COMPLIANCE CALCULATIONS FOR A PART ARE NOT AS
EXPECTED.

Root Cause: When updating a specification, the cache table specification_substances is
not refreshed.

Resolution: After modifying an existing specification, the cache table specification_
substances will be cleared according to the specification.

Bug ID 22385677: BAD INDEX 1:1 WHEN CLICKING ON ATTACHMENTS TAB
Root Cause: When the file version is loaded, there is an Out of Range error.

Resolution: Check the version size before loading.

Bug ID 22854830: EXPORT MANUFACTURER DOES NOT INCLUDE THE
RELATIONSHIP INFORMATION
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Root Cause: The total number of supported tables is not updated when adding
support for the Relationship table, and this causes the relationship table to be ignored

Resolution: Update the total number.

Bug ID 22905607: DMS HEADER PROPERTIES OF AN ATTACHMENT OPEN
THROUGH AUTOVUE HAS WRONG INFORMATION

Root Cause: The vuelink did not pass F5 cookies info to the request header, so F5 can
not correctly load the balance.

Resolution: Add all cookies when executing a web service request from AV.

Bug ID 22898248: RUNNING CHANGE PACKAGE REPORT BRINGS AGILE 9.3.4
SYSTEM DOWN

Root Cause: There is a loop condition.

Resolution: Remove the loop condition.

Bug ID 22898970: UNABLE TO IMPORT SOME FIELDS FOR COSTING

Root Cause: This issue was introduced when upgrading POI-3.0.1-Final to
POI-3.5-Final in the Agile 9.3.1 release. The way to check whether a FormulaRecord
has a cached string value in the following StringRecord is change in POI-3.5-Final.

Resolution: Use the new method FormulaRecord .hasCachedResultString() in
POI-3.5-Final.

Bug ID 22917939: 'HAS PENDING CHANGE' FLAG IS INCORRECTLY SET ON ITEM
THAT HAS NOT CHANGED

Root Cause: We do not copy the Item status flag from the old row to the new row if
there is a redline on any attributes on the Item BOM.

Resolution: If any attributes of the Item BOM are redline, copy the item status flag
from the old row to the new row.

Bug ID 22822669: FAILED CHECK IN FILE WITH A SPCECIAL NAME
Root Cause: The wrong method is used to fetch the file name and suffix.

Resolution: Correct the code to get the correct filename and suffix.

Bug ID 23004827: DURING IMPORT SPECIAL CHARACTERS GET OVERWRITTEN,
WHEN USING TRANSEXTERNAL ROLLUP RETURNING INCONSISTENT &
INCORRECT CALCULATED CONC RESULTS ON SP
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Root Cause: The incoming value was encoded by WebSecurity API and inserted into
the database.

Resolution: The value encoded by WebSecurity API should only be used to display in
the web Ul and the original incoming value should be inserted into the database.

Bug ID 23071115: EXPORT A CHANGE ORDER WITH A SPECIFIC SITE ERROR

Root Cause: A null point exception is caused by a check for privilege on a null
revision.

Resolution: Check if the revision is null before checking privilege.

Bug ID 23101220: EFFECTIVE BOM EXPLOSION REPORT HAS NO DATA
Root Cause: Date conversion error between user format and database format.

Resolution: Only do the conversion when displaying date on the UI.

Bug ID 23108843: CANNOT ADD ANY BOM COMPONENTS TO ITEM

Root Cause: Length of collection t_varchar2s defined on system level is 32. When the
object number is larger than 32, doing an external rollup throws a numeric or value
error exception.

Resolution: Exceed length of t_varchar2s to 300.

Bug ID 23065019: USER WITHOUT READ PRIV TO THE USERS CAN SEE THE LIST
OF CHANGE ANALYSTS

Root Cause: When getting possible values for users, the system does not check
whether the current user has privilege to access the users in the user list.

Resolution: Added a privilege check when getting possible values for users.

Bug ID 23139730: VISIT AGILE PLM SERVER BY IP ADDRESS, CAN NOT UPLOAD
FILE

Root Cause: Only the URL entered in Java Client's Web Server URL can be used to do
file upload file. This is used to check the origin of the request that can be allowed to
access file server for uploading from Web Client. Therefore, the IP address of the
server will also be treated as an unaccepted URL.

Resolution: We provided configuration in the file server's server.conf for extra access
URLSs so that the File Server considers those URLs as valid
"Access-Control-Allow-Origin". Post-installation of each file server, add those extra
Agile access URLs to the configuration parameter "extra.allowedorigin.appurl”, and

nn

separated by ";". This solution can also be used for proxy servers.
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Bug ID 23195668: ADD AN ITEM IN THE RELATIONSHIP OF ANOTHER ITEM VIA
SDK API AND JS

Root Cause: When the user attempts to enable an event trigger, update event
information fails because row Object ID is set incorrectly. Thus, when Object cache is
created, it throws a "no target object class ID" exception.

Resolution: Change the server event code to get the correct object ID.

Bug ID 23146980: NOT ABLE TO RESTRICT EXTERNAL USER READ ACCESS
BASED ON #CURRENTREV

Root Cause: Get the incorrect change key when the row under the Al tab is
highlighted.

Resolution: Use the proper logic to get the correct change key when the row under Al
tab is highlighted.

Bug ID 23183928: PERMISSION ISSUE WHEN LIMITING ACCESS TO WORKFLOW
NEXT STEP

Root Cause: The Agile System checks the privilege of change backward status
privilege to decide whether the Next Status button is available.

Resolution: Enable the Next Status button if the current status has next status even if
there is no default backward status.

Bug ID 22910065: SDK IQUERY DOES NOT WORK AFTER MOVING TO 9.3.4
Root Cause: ADList.getIDNamelList() returns the wrong value for supplier list.

Resolution: Fix the issue.

Bug ID 23219770: UNABLE TO USE FILL-DOWN IN CHANGE ORDER'S AFFECTED
ITEM

Root Cause: Fill down/up in UI only uses the id value of the selected LCP cell to set
rows below /up. The id of LCP may not in all other classes.

Resolution: Added LCP check for fill down/up LCP cell case. If class does not have
the LCP with the replace id value, but has same name LCD, the system uses the same
name LCP in this class to do the replace.

Bug ID 23213968: MISSING DOT ICON ON ATTACHMENT TAB
Root Cause: The Attachment flag is not updated after inserting into table REV.

Resolution: Insert the latest attachment record into table REV by popup window to
select process model (with or without attachment) according to Java Client settings.
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Bug ID 22650284: CANNOT IMPORT MAPPED MS PROJECT

Root Cause: In 934, we only certify the MSP2010 base version, not any upgrade
versions (14.0.7165.5000 or above). On the customer side, the version is 14.0.7165.5000.
Microsoft project delivered a patch to solve some security issues and it made some
cases not work for PPM/MSP integration.

Resolution: Changed code to adapt new MSP version (14.0.7169.5000).

Bug ID 23508732: NUMERIC P2 ATTRIBUTE VALUE IS NOT DISPLAYED WHEN
TYPE IS DOUBLE

Root Cause: This issue is caused by HF934.11 that supports the flag
isLoadPartsP1P2P3InBatch. If the client sends this flag, there is a ClassCastException
error thrown when A9 code tries to cast a string to double type.

Resolution: Resolve the ClassCastException and make sure that the client gets the
correct the numeric.

Bug ID 23521927: VALUE BEING APPENDED INSTEAD OF OVERWRITTEN TO A
BOM ITEM NUMBER

Root Cause: 934HF29 causes the append issue in the BOM Item number.

Resolution: Fix 934HF29 so that BOM Item number and Manufacturer Part number do
not get appended to.

Bug ID 23497688: EXPORT WEB SERVICE FAILED WHEN USING SOAP UI TOOL

Root Cause: Validation is failed when soapui opens the WSDL file. That is because the
XML element <xs:all> has the 'unbounded' definition for its child elements in the
export schema definition. The child elements, however, only occur zero or one time.

Resolution: Correct the schema definition.Use the element <xs:sequence> instead of
<xs:all> to fix it and <xs:sequence> specifies child elements can only appear in the
order mentioned.

Bug ID 23086616: WEB SERVICE EXTENSION (WSX) HAVE TO CALLED
INTERNALLY BEFORE THEY

Root Cause: Apache reversed proxy is used and SSL is enabled at the proxy tier, but
WebLogic application server does not enable SSL. While the user accesses the WSX
URL via HTTPS, the request URL protocol is HTTPS, so the WebLogic application
server can not publish the web service to a HTTPS URL address.

Resolution: Construct an HTTP URL address to publish the web service.

Bug ID 23254372: ATTRIBUTE HISTORY REPORT DOES NOT GENERATE THE
ATTRIBUTE CHANGE HISTORY
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Root Cause: This issue is caused by the defect of bug [10205415]. An object cannot get
the right subclass/class id, if the customer set privilege on subclass/class level, it skips
rev related info.

Resolution: Set the correct subclass/class id for object and check privileges.

Bug ID 23703346: EXTERNAL ROLLUP (BATCH AND AD-HOC) NOT RETURNING
SUBSTANCES IF BOM PART QTY IS 0

Root Cause: When one of the BOM part’s QTY is set to 0, there will be a substance
whose calculated mass is 0 in table result_substance_compliance. When validating the
substance, the total count (include 0) and valid count (non-zero) in table result_
substance_compliance does not match. As a result, no substance will be returned.

Resolution: Making valid count include 0 substance.

Bug ID 23732544: % COMPLETE DOES NOT MATCH FOR MILESTONE WHEN
DURATION IS 0

Root Cause: For the Gate object, when importing from MSP to PPM, percent complete
column will be reset to 0 duration. It is considered as a defect.

Resolution: Set percent complete to the value before importing Gate object.
Related Bugs:

23666747: SUCCESSOR AND PREDECESSOR LINKLAG NOT PROPERLY
IMPORTED

24494414: OOB - ESTIMATED FLAG OF PPM GENERATED ACTIVITY/GATE
SHOULD ALWAYS BE SET TO NO

Bug ID 23723485: BUSINESS OBJECT WEB SERVICE
Root Cause: Double value from SOAP request is not formatted properly.

Resolution: Correct the format.

Bug ID 23718233: SDK IQUERY DOESN'T WORK AFTER MOVING TO 9.3.4

Root Cause: The server side does not return list value for criteria-based dynamic list
for supplier.

Resolution: Use a special handler to return criteria-based supplier list value.

Bug ID 23490591: INTRODUCED, APPROVE/REJECT/ACKNOWLEDGE BUTTONS
VISIBLE

Root Cause: After the workflow is signed off and auto-promotes tothe next status, the
user has no read privilege on this object, yet the Approve, Acknowlege, Reject and
Comment buttons are still available because the read privilege is not checked.
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Resolution: When clicking these buttons, check the read privilege of the current user in
JSP Pages.

Bug ID 24289278: IMPORTED MPP PROJECT AUTOMATIC UPDATE OF DURATION
OF PPM WHEN EDITING AND SAVING

Root Cause: When the display type of Calendar Library is set to Search, the format of
the selected entry is like ClendarName=CalendarID, not just CalendarID in the
dropdown list. The calendar ID is parsed as 0 and gets non-working day as working
day. This is why the schedule end date moved forward.

Resolution: Change the code to adapt for both formats: calendarID or
ClendarName=CalendarID.

Bug ID 24312919: NOT ABLE TO EXPORT CHANGE WITH SPECIFIC SITES EVEN
AFTER INSTALLING PATCH 125

Root Cause: When the PGC license is disabled, some special attributes are not
readable, and the export logic tries to remove attribute values from revision, but the
revision could be null.

Resolution: Check revision before using it.

Bug ID 24344788: LARGE TEXT DOES NOT SUPPORT CHANGE CONTROLLED
FUNCTIONALITY AND REDLINE CHANGES

Root Cause: Large text data is not copied from P3 when releasing a change.

Resolution: Copy the large data for Page 3 in the release change process.

Bug ID 24285313: AFTER SAVE/CHECK-IN, LIST VALUE WITH SPECIAL
CHARACTER NOT VISIBLE

Root Cause: This issue is caused by the list values which have the special character
defined by regular express. Since the ECS implementation is based on search that
supports regular express character to match, if the matching is not correct then it can
not save the value to Agile Server.

Resolution: For this case, we do not need to consider the value if there is a regular
express character. Ensured that the value can be saved to the Agile Server and can be
displayed in web UI correctly.

Bug ID 24368578: UNABLE TO IMPORT THE PPM PROJECT FROM ONE AGILE
INSTANCE TO ANOTHER

Root Cause: This is a code defect. There is an out of boundary exception of int when
handling linklag of dependency.

Resolution: Changed from int to long for this case
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Bug ID 23616874: JAVA.NET.PROTOCOLEXCEPTION ON AGILE SSO
ENVIRONMENT WHEN ADDING AF

Root Cause: The response buffer flush is not correct when adding object by search.

Resolution: Set correct response string length, and refresh buffer.

Bug ID 23249804: UPLOAD FILE FAILED IF CHOOSE UNZIP OPTION

Root Cause: The uploaded file name is encoded by GB2312, but Agile uses UTF-8 to
decode file name.

Resolution: Use UTF-8 to decode the file name. If it fails, try to use login user
preference settings.

Bug ID 24401812: GATE ESTIMATED END DATE CANNOT BE SET TO AN EARLIER
DATE ONCE SET

Root Cause: This is a code defect. For the Gate object, Estimated End Date is always
the same as Estimated Start Date. When choosing an earlier date, it will ignore it.

Resolution: Need to specially handle Estimated End Date for Gate.

Bug ID 24529954: SSL CONFIG ON DFM CAUSING HTTP AND HTTPS MIXED
CONTENT

Root Cause: The download servlet cannot get the correct URL when doing a forward.
Therefore, it uses the request URL to redirect the request, but sometimes the request
URl is different from the user preferred File Manager URL. This causes a download
fail.

Resolution: Put the user preferred URL in the request parameters instead of request
URL.

Bug ID 24573174: SEARCH FAILS -- ERROR: ORA-00904:

Root Cause: The customer created flexible attributes and they are all stored in the
agile_flex table. Those flexible attributes default admin value is not Database column.
Query side gets invalid database column when parsing the database column for
flexible attribute.

Resolution: When the query condition or output attribute is flexible attribute, handle it
to get the correct database column value as multilist value.

Bug ID 24572430: NO DUPLICATE NAME REMOVAL SUGGESTION WHEN
ADDING SAME USER AS APPROVER AND OBSERVER

Root Cause: The duplicate names removal suggestion window has been removed since
9.3.2.
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Resolution: Implement these functions when duplicate names are found. The user can
click 'Resolve duplicates' button to launch the suggestion window.

Bug ID 24610371: PROJECTS MUTLIST01 VALUE ON FILES TAB OF FILEFOLDER
DISAPPEARS ON

Root Cause: This is a discussion cache issue. We do not refresh cache after the
attachment file is changed.

Resolution: Refresh Attachment table when adding files to file folder.

Bug ID 24613961: YOU DO NOT HAVE THE READ/DISCOVER PRIVILEGE
OCCURS WHEN TRY TO OPEN OBJECT

Root Cause: When loading the discover object with multi QCR /PSR objects at one
execution, some of the resulting discover objects lose the supplier/customer attribute.
This makes it so that the user cannot pass the privilege check in issue case.

Resolution: Correct logic to discover object for QCR/PSR.

Bug ID 24577918: EMPTY BOM COMPARISON REPORT IS GENERATED

Root Cause: The BOM Comparsion report does not handle special characters when
generating XML files.

Resolution: Handle XML special characters.

Bug ID 24614700: ACS SUBSCRIBER PROCESSING ALL RECORDS DESPITE NO
CHANGES

Root Cause: While there are two subscriber detail rows with different filter, or role, or
format, the ATO created by the scheduled subscriber is extracted multiple times, thus
the selected object version is increased multiple times, that cause error while checking
if the selected object was changed by its version.

Resolution: Increase the object version in the ACS extract track table and adjusted the
SQL query accordingly

Bug ID 24674751: JOB FUNCTION TEAM DOES NOT GET NOTIFY WHEN
AUTOPROMOTE SET TO YES

Root Cause: When using auto promote to change status, Agile fails to get Users/User
Groups based on job function id using existing APL

Resolution: Get the Users/User Groups based on job function when getting notify
users during auto promote.
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9340_198

9340_199

9340_200

9340_201

9340_202

9340_203

Bug ID 24741613: UPDATE TABE EVENT THROWS ERROR NODE 0 DOESN'T NOT
EXISTE FOR TEMP

Root Cause: For BOM blank row, an exception is thrown when event is triggered.

Resolution: Need to have a special handler for a blank BOM row when event is
triggered.

Bug ID 24745790: HUGE BOM IN AFFECTED ITEM REDLINE SWITCH BETWEEN
VIEWS TAKE LONG TIME

Root Cause: Do not cache the data for the BOM table.
Resolution: Cache the data for the BOM table.

Bug ID 24741653: APPLICATION ERROR WHILE RUNNING "ATTRIBUTE HISTORY
REPORT" FROM ACTIONS MENU

Root Cause: Missed privilege check while displaying the Attribute History report in
the Item action menu.

Resolution: Disable the Attribute History report in the Item action menu unless the
user has privileges to discover, read and run the Attribute History report.

Bug ID 24712312: CANNOT CREATE MULTIPLE PROJECTS CONCURRENTLY
USING THE SAME TEMPLATE

Root Cause: When creating from a template unsuccessfully, we set the template's
object id as the new object id.

Resolution: When creating from a template unsuccessfully, set the new object id as
null. Meanwhile correct the error message and return the failed status when creating
the relationship unsuccessfully.

Bug ID 24766324: SDK FAILS TO RECOGNIZE THE VISIBILITY OF THE FIELD AT
SUBCLASS LEVEL

Root Cause: The Class ID is used to get the Page Two attribute meta data, so the Page
Two attribute visibility is wrong at the sub class level.

Resolution: Use the subclass ID to get the attribute admin meta data.

Bug ID 24566091: ARCHIVED TEMPLATES APPEAR IN SEARCH DIALOG RESULT
Root Cause: We do not filter archived template when creating from template.

Resolution: Filter archived template when creating from template.
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9340_206

9340_215

Bug ID 25036713: MERGE HF 155 WITH TO ALIGN GOOGLE CODE BASE
Root Cause: HF155 is incompatible with HFS.
Resolution: Provide HF206 to be compatible with HFS.

Bug ID 25091503: HAS PENDING CHANGE FLAG IS INCORRECTLY SET ON ITEM
THAT HAS NOT CHANGED

Root Cause: We do not copy the Item status flag from the old row to the new row if
there is a redline on any attributes in the Item BOM.

Resolution: When redlining any attributes of an Item’s BOM, copy the Item’s status
flag from the old row to the new row.

PLM Release 9.3.5.0

9350_1

9350_3

9350_5

9350_8

This section includes Hot Fixes included in Agile PLM 9.3.5.0.

Bug ID 23096623: SUPPORT FOR "GENERATE MOBILE STREAMING FILES" FROM
AGILE

Root Cause: N/A

Resolution: This is an enhancement.

Bug ID 22585512: AGILE9.3.5 PRODUCT SUPPORTS EDGE AND IE11 BROWSERS
OF WINDOWS 100S

Root Cause: The 935 product does not support IE11 and Edge browsers in windows10
0s.

Resolution: Start to support Edge/IE11 of windows 10 OS in 935 with this HF applied.

Bug ID 22777068: THE MULTI-TEXT FIELDS WRAP THE TEXT IN THE MIDDLE OF
A WORD

Root Cause: word-break: break-all; This CSS property breaks word.
Resolution: Remove this CSS property:word-break: break-all;

Bug ID 22950364: SETCRITERIA DOES RESULTS IN
JAVA.LANG.NULLPOINTEREXCEPTION FOR GRO

Root Cause: Null point exception

Resolution: If the query is created using base change, then exclude the Affected Files
table from searchable tables.
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9350_10

9350_11

9350_21

9350_22

9350_23

9350 _24

Bug ID 22957414: USING SET AS BEST, PCM COST CALCULATION IS WRONG IN
ASSEMBLY COST

Root Cause: We do not pass the Material Price Adder attributes, so it does not include
them in the total extended price.

Resolution: Invoke the related method with the Material Price Adder attributes.

Bug ID 23177608: EC SERVICES TO SUPPORT MCAD 3.5
Root Cause: EC Service does not support MCAD3.5.
Resolution: EC Service improved to support MCAD3.5.

Bug ID 23212335: CURRENCY RATE AT TIME OF QUOTATION, THE PROJECT
SHOULD KEEP OLD CURRENCY RATE

Root Cause: The system misses the project snap date when getting the report in issue
case.

Resolution: Added project snap date when getting report in issue case.

Bug ID 23220900: BOM TAB REFRESHES TO TOP OF TABLE IN INTERNET
EXPLORER 11 (IE11)

Root Cause: TreeGrid source Update6.js 374th lines if(this.MainTable)

"

this.MainTable.style.display = "none"; this.MainTable.style.display ="";

Set the display property of MainTable to none' and set it back; the vertical scollbar will
miss its position.

Resolution: Remember the scrollTop of vertical scrollbar before setting the display
property of the MainTable then set it back.

Bug ID 23487699: ATTRIBUTE NAME (LABEL) IS WRAPPING IN MIDDLE

Root Cause: word-break: break-all;

"non

This CSS property breaks word. When it contains the " " characters in output text,

word-wrap: break-word property can not work well.
Resolution: Remove this CSS property: word-break: break-all;

Replace " " by one general space no matter how many spaces the user types in the label
attribute.

Bug ID 23623623: CREATE ITEM WITH NUMERIC ATTRIBUTE VALUE ADD EXTRA
DIGITS AFTER DECIMAL PLACES

Root Cause: The number value is not rounded.
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9350_25

9350_26

9350 _27

9350_28

9350_29

9350_30

Resolution: Round the double value with the admin attribute scale.

Bug ID 23596732: DRAG AND DROP ITEM ON UPDATE TABLE EVENT FAILING
EVEN WITH 9.3.3.0

Root Cause: The change key object ID could be '-1', but this is not a valid object ID. It is
not caught and handled properly in EventDirtyRowUpdate#getReferent().

Resolution: If the change key object ID is -1, then set the change object key to null.

Bug ID 23597068: SIZE ATTRIBUTE(ITEM.DOCSIZE) IS NULL WHEN EXPORT
Root Cause: Always Use Parts.Title Block.Size attribute info to resolve list value.

Resolution: If object class is Document, then use the Document.Title Block.Size
attribute info to resolve list value.

Bug ID 23597938: JAVA PX ERROR DURING FILE UPLOAD IS NOT DISPLAYED IN
WEB CLIENT UI

Root Cause: The UI does not handle the error message from the Agile server.

Resolution: Display error message and do not refresh table.

Bug ID 23596802: AFTER APPLYING 9.3.3.0.258 LIFECYCLE PHASE ERRORS OUT:
JAPANESE ENVIRONMENT

Root Cause: The is a Japanese language-specific issue. The XML data file in the XLSX
file may contain the 'rPh' element. The 'rPh' shows pronunciation of the data text, but
the data text inside it should not be extracted.

Resolution: Do not extract data inside 'rPh' element.

Bug ID 23597997: CHECKIN JAVA PX ERROR DOES NOT REFLECT UPLOAD
STATUS ON FILE UPLOAD

Root Cause: 1. JavaScript does not correctly update the page after the exception is
caught 2. The server updates the DB table HISTORY_FILE_UPLOAD, setting
UPLOAD_STATUS=1, before the exception is thrown. Also, there is no rollback action
after the exception is caught.

Resolution: 1. Set the error message in the callback function of the check in action in
JavaScript. 2. Rollback the DB entry after the folder check in fails.

Bug ID 23623242: ADD AND REMOVE BUTTONS ARE ACTIVE IN DFCO
RELEASED STATUS

Root Cause: This bug is caused by the special handler for the DFCO privilege check
return before the workflow status check.
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9350 _31

9350_34

9350_35

9350_37

9350_39

9350_43

Resolution: Move the special handler for the DFCO privilege check after the workflow
status check.

Bug ID 23624757: DESCRIPTION IS NOT FILLED WHEN ITEM CREATED BY
IMPORT

Root Cause: Import does not handle special characters in Characters set while doing
format validation. For example, it does not treat /s as blank space.

Resolution: Convert special characters in Characters set before doing format
validation.

Bug ID 23706122: IMPORT NON VISIBLE MULTILIST VALUE ENDS IN FATAL
EXCEPTION OCCURED

Root Cause: Import tries to update an invisible multilist attribute which causes an
ArraylndexOutOfBoundsException.

Resolution: Do not update invisible multilist attribute.

Bug ID 23596625: GETFILENAME USED IN PROCESS EXTENSION DURING
CHECKIN DOES NOT RETRIEVE EVERY FILE

Root Cause: This is caused by a code defect. When checking in multiple files, the
application does not get all filenames and file ids for event info.

Resolution: Loop all file names and file ids, and construct file name string with all
files.

Bug ID 23743008: UNABLE TO BLANK OUT NUMERIC ATTRIBUTE FIELDS

Root Cause: If the numeric field is blanked out, the code to parse the entered value
returns a NULL Number object, and getting ouble vlaue by Number.doubleValue will
throw NULL pointer exception.

Resolution: Rewrite the logic to compare entered value and old value.

Bug ID 24320626: NO DUPLICATE NAME REMOVAL SUGGESTION WHEN
ADDING SAME USER AS APPROVER AND OBSERVER

Root Cause: The duplicate names removal suggestion window has been removed since
9.3.2.

Resolution: Implement these functions when duplicates names are found. User can
click Resolve duplicates' button to launch suggestion window.

Bug ID 24350803: UPDATE TABLE BOM/MANUFACTURERS/ATTACHMENT NOT
WORKING ON IEV
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9350 _44

9350 _45

9350_46

9350_47

9350_51

Root Cause: The API CMSessionBean.logUserDefined ActionWOVersionChang e( ...)
should not lock object.

Resolution: Change the API to not lock the object.

Bug ID 24350846: WHEN REMOVING ATTACHMENT
IEVENTDIRTYROW.GETACTION() RETURN NUMBER

Root Cause: Agile 935 defined some new delete actions for DFCO related features on
the server side and event framework use it directly.

Resolution: If it is a delete action, the API IEventDirtyRow.getAction() always returns
1.

Bug ID 23762754: IE 11, EXTRA PAGE

Root Cause: If the browser is not FF or IE10 it always opens another window to check
JRE.

Resolution: Skip open the JRE check window when using IE11.

Bug ID 23857331: CANNOT CONFIGURE CHECKOUT PRIVILEGE FOR DESIGNS

Root Cause: After 9350.11, the application does not check the checkout privilege by
object type. This is code defect.

Resolution: Check the checkout privilege by object type.

Bug ID 24422906: HF CONFLICT 9.3.5.0.11: CHECKIN JAVA PX ERROR DOES NOT
REFLECT UPLOAD STATUS ON FILE UPLOAD MANAGER.

Root Cause: HF conflict.
Resolution: Rebase HF, this HF includes the code fix for HF935.27,935.29,933.388
Related Bugs:

24422592: HF CONFLICT:JAVA PX ERROR DURING FILE UPLOAD IS NOT
DISPLAYED IN

24422674: CHECKOUT EVENT ON MULTIPLE FILES NOT RETURNING CORRECT
ITEM REVISIT

Bug ID 24447418: GANTT CHART SHOWS BLANK SCREEN AFTER SAVING

Root Cause: When saving a Gantt Chart, it has 2 steps: update and refresh and expand
all the leaf nodes. The Ul is set to editable and the user can edit few cells during the
period - after updating before refreshing, after expanding all, user will be confused as
changes are messed up. The Refresh action is introduced in 934 comparing with
previous version.
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9350_52

9350_56

9350 _58

9350_59

9350_60

Resolution: Remove the Refresh action from the Save action just as in the previous
version.

Related Bug 24592414: GANTT CHART ERROR WHEN DELETING TASKS

Bug ID 24448116: EXTERNAL ROLL UP NOT ACCURATE

Root Cause: It does not find out the exact rev of the BOM child for ECR on external
rollup process.

Resolution: Set the latest MCO or ECO rev as ECR's version.

Bug ID 24572867: EC 3.5 - WORKSPACE MANAGER REFRESH PERFORMANCE

Root Cause: Dynamic list is enabled to search PLM objects. From one web service call,
the MCAD client send many objects to Agile and the search query is executed for
handling every object (including Design and Item objects) even if the result is the
same. These queries takes most of the time.

Resolution: When refreshing in the workspace window, the MCAD client sends the
web service request to load the P1P2P3 information of these objects. Once PLM get the
request, the web service RetrieveDesignStructure implementation just needs to return
the information of the P1P2P3 and make sure these redundant queries are not
executed.

Bug ID 24699716: ATTACHMENT FILE NAME INCLUDING PARENTHESIS AND
DOT CANNOT BE OPENED

Root Cause: Cannot get file type when file name contains dot and parenthesis.

Resolution: Get the correct file name and file type.

Bug ID 24685758: CANNOT FIND ANY SUBSCRIBER IN EVENT SUBSCRIBERS TAB
OF DOCUMENTS CLASS

Root Cause: The following two classes are not packaged into pcserver.jar
com/agile/admin/server/HistoryRecordable.class
com/agile/admin/server/ ADNodeAssign.class

Resolution: Added the two class into usedejbclasses.txt to make sure the 2 class will be
packaged into pcserver.jar.

Bug ID 24755937: USERS CANNOT ADD ADDERS IN THE QUOTATION SANDBOX
A SECOND TIME

Root Cause: When changing price adder by part, by commodity, by supplier, Agile
updates the changed adder value and loses the values of other adders in the same
price point.

Resolution: Add the original adders's values to update when adding price adders.
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9350_62
Bug ID 24848907: SEARCH TEMPLATE RETURNS NO RESULT

Root Cause: Do not filter archived template when creating from template.

Resolution: Filter archived template when creating from template.
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Resolved Issues

This chapter lists issues that were resolved during this release.

For each resolved issue, on the first line, the number is the internal Defect number.

Product Collaboration

18858771
Changes

Issue: PENDING CHANGE WARNING LOOP FOR ITEMS THAT HAVE EQUAL
SIGN IN PARTNUMBER

Root Cause: The privilege check for an object in a dynamic list depends on its default
latest change since the criteria is based on the lifecycle phase attribute, but the rev is
gotten from the context is for the parent object. This is why the privilege check returns
an incorrect result.

Resolution: Reset rev info in context before doing the privilege check for the selected
value of the dynamic list.

Verification:

1. Log in to Web Client.

2. Create a new Part named 15600-SA=.

3. Create a new Change from Part 15600-SA= named Change C00222.
4. Go to a 15600-SA -> Actions menu > Create new changes again.

A Warning message window appears saying Part 15600-SA= is already on pending
changes: C00222.

5. Click Finish in the warning windows.

Result: It works fine without a duplicated message window appearing.

20217800
Roles & Privileges

Issue: USER WITH LIMITED DISCOVER AND READ PRIVILEGE CANNOT SEE
ITEMS MULTILIST FIELD C
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Root Cause: The privilege check for object in dynamic list depends on its default latest
change since the criteria is based on the lifecycle phase attribute, but the rev from the
context is for parent object. That's why the priv check returns an incorrect result.

Resolution: Reset rev info in context before doing the privilege check for selection
value of dynamic list.

Verification:

1. Create a Part with sammiO3 role with the following privileges:
Discover/Read/Modify changes

Display No Privilege Fields: Yes

Read Items with same new criteria

Discover parts with new criteria:

Parts Title Block.Lifecycle phase In production

or

Parts Title Block.Lifecycle phase In frozen or

Parts Title Block.Lifecycle phase In prototype

Set Part.P2.multilist01 with Items dynamic list.

Log in to Web Client as admin.

Create a Part, P001, and create ECO, c0001, for it.

Set Lifecycle with production.

Release C0001.

Create P002 and create ECO, c0002, and release C0002 and with lifecycle: frozen.

N o a Db

A Warning message window appears saying Part 15600-SA= is already on pending
changes: C00222.

8. Create a p003 and create ECO, c0003, release c0003 and with lifecycle: prototype.
9. Open P001 and modify p2.multilist01.
10. Input p002 and p003 and save it.
11. Log in to the system as sammi(03.
12. Search for P001 and open it.
13. Check the p2.mulitlist01 values.
Result: The p002 and P003 are displayed correctly in the p2.multilist01.

20272396
Workflow
Issue: FAIL TO ADD AFFECTED ITEM

Root Cause: When changing the status of an ECO and meeting
ExitCriteriaNotMatch /EnterCriteriaNotMatch error, the ECO’s OBJVERSION will +1
while the OBJVERSION on page was not changed (without refreshing the page).

Resolution: After closing the audit status dialog, refresh the page.

Verification:
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Log in to the Java Client as admin.

2. Go to the workflow: Default change orders.
3. Save as new workflow: Default change orders_2.
4. Go to the Default change orders_2 to status and create a review?2 status and move
to CCB and under it.
5. Go to Classes > Change Orders > ECO > Page three list01.
6. Enable it and assign the new simple list01:Yes/No.
7. Saveit.
8. Go to the criteria (newchangeorder_1) with the following condition:
Type: ECO
Condition: Affected Item.Item number is not null and Page Three.list01 in yes.
9. Go back to Default change orders_2 with review2 status.
10. Create a Criteria with new newchangeorder_1.
11. Create change status for this workflow Default change orders_2 assign to users.
12. Log in to Web Client.
13. Create an ECO and change status to review_2. The following error message
appears: "No matching entry criteria. Review_2".
14. Click Close.
15. Click Add and click the Create New button.
16. Go to the Create new tab of Create Part.
17. Click Add.
Result: The value is created successfully and added into the Affected Items tab.
20767804

Folders, Files & Attachments

Issue: CANNOT CLICK ADD TO UPLOAD FILE IF ONCE UPLOADED TO OBJECT
WITH DOUBLE QUOTE

Root Cause: Double quotation is not supported.

Resolution: Added code to handle double quotations.

Verification:
1. Log in to Web Client.
2. Create a new Item and name it abc"123. (There is a double quotation mark in the

name.)

Upload a file attachment. It succeeds.

Log out and log in again to Web Client as the same user.
Try to open any object, go to Attachment tab, click Add.
Result: File Upload works successfully.
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20846622
Changes

Issue: AUDIT RELEASE: ON SAME CHANGE GIVES DIFFERENT ERRORS
DEPENDING ON ACCESSED FROM

Root Cause:

Case 1: The root cause is that when we open an Item with a certain rev the rev
information is stored in the user context. When the user then opens a Change object to
do an audit some privilege checks will be done for Affected Items using the rev
information stored in user context. The mismatch between rev stored in user context
and Affected Item object causes the problem. If there is criteria related to rev or rev
attributes the priv check returns wrong result.

Case 2: Once the user manually changes the tab name from 'Page Two' to 'Document
Info' the new hereditary node is created in the database for this subclass level table.
The fix of 934HF42 gets the subclass node by invoking some admin side AP]I, but it
returns the wrong node which causes the problem.

Resolution:

Case 1: Reset rev for correct Al's which is being dealt with at run time, and set the
original rev back to context after the required fields check is finished.

Case 2: Check if the enabled tab id either equals to one of the enabled tables at
subclass level, or equals to any inherit id of the enabled tables at subclass levels.

Verification:
1. Log in to the Java Client as admin.

2. Go to Classes > Parts > Page Two > Enable page Two.list01 and Title.block.product
line to Yes.

3. Create a user named user01 with below privilege:
Discover/Read/Modify changes
Discover/Read Parts

Modify privilege only for parts that 'Title block.rev release date is not null' with
apply to all

4. Go to the workflow, edit criteria for release status of default change orders, set exit
required fields as page Two.list01 and Title.block.product line.

Log in to Web Client as admin.
Create a Part, part0001, and create an ECO C00001 for it.
Release C00001 with A version.
Log in to Web Client as user01.

© ® N o o

Go to C00001 directly and do an audit release. Audit result shows correct
warnings without any insufficient privileges'.

10. Go to Part0001, the edit button is enabled since current rev is A and rev release
date is not null. Now choose 'introductory' rev and you can find that the Edit
button is greyed out. This is correct since rev release date is blank for rev
introductory.

11. Go to the part0001's Change History tab and open C00001.
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12. Go to the C00001’s Actions and click Audit release

Result: Check the Audit release table, there is a message: "The following required
fields are missing: Part0001: Page Two.list11 and Title.block.product line".

20960104
Changes

Issue: THE RECENTLY SELECTED USER GROUP IS CLEARED IN DROP-DOWN
LIST OF REVIEWERS

Root Cause: Cursor in an Iterator is to the last, making some code uncovered.
Resolution: Reset the cursor to the beginning.

Verification:

1. Create over 200 User Groups.

Create the Change Order and assign the workflow.

Change status to CCB.

Launch the palette for approvers.

a & 0N

Select the Search within a User Group option and select User Group,
UserGroup101.

Search for a user in UserGroup101 and return to the Change Status window.
Launch the palette for approvers/acknowledgers/observers.

UserGroup101 is listed in the dropdown list of search type.

© ®» N O

Close the Change Status window.
10. Open the Change Status window.
11. Launch the palette for approvers/acknowledgers/observers.

Result: UserGroup101 is listed in the dropdown list of search type.

21615075
Changes

Issue: STATUS CHANGE COMMENTS SPECIAL CHARACTERS CONVERTED TO
HTML HEXADECIMAL CODE

Root Cause: When you refresh to the Comments page, the value of comments is
encoded twice.

Resolution: Encode only one time.

Verification:

Precondition: Set the notification in the Java Client.

1. Log in to Web Client as admin.

2. Create an ECO, c0001.

3. Click Next Status and assign a workflow for it.

4. Click the Continue button and go to the table of "Change Status to Submitted."
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5. Assign one notify user, user01, who can get email with related privilege and in the

AN N

comments field, put some special characters as follows: "?", "!",";", "("," /", "or ", ":",
”[”/ '””I@/NI\/ | /{}/\/[]/?/>I</+/0/0/$I3IA/&/*/()/—+@I!I#

6. Click Finish.
7. Go to the History tab.
8. Check the comments field.
Result: All the special character appear as they should in the comments field.
9. Check user email.

Result: In the email comments field, the special values are displayed properly.

21786162
Web Client

Issue: AFTER UPGRADING FROM AGILE 9.3.1 TO 9.3.4 ITEM ATTACHMENTS TAB
IS MISSING FILE NAME, FILE DESCRIPTION

Root Cause: This is an AUT bug. The fix requires the customer to upgrade again from
931 to 933 with the fixed script, but the data after 933 will be lost.

Resolution: Use the fixed script.

Verification:

1. Login to Java Client or Web Client.

2. Open Item, P03673, and click Attachments tab.

3. Verity Filename, File Description, File Size and File Type.

Result: Filename, File Description, File Size and File Type are displayed
appropriately.

21807870
Web Client

Issue: SELECTED CONTENT TAB REV FIELD DOES NOT DISPLAY LATEST
REVISION ON WEB CLIENT

Root Cause: The introductory revision of an Item object is always added to the
selected content table of CTO from Web Client.

Resolution: Always add the latest released revision of the Item object to the selected
content table of CTO when it is from Web Client.

Verification:

1. Log in to Web Client.

2. Create a Part, P1.

3. Create an ECO against the Part P1, and release it with revision A.

4. Create a CTO, go to Selected Content tab and add P1, check the Rev field.
Result: The Rev field displays latest revision A.
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21815271
Java Client

Issue: USER NOT ABLE TO VIEW ATTACHMENTS FROM WHERE USED TAB
BEFORE REFRESHING PAGE

Root Cause: When the Relationship table of the Item object is loaded, the data model
of the Relationship table is stored in the action context, so at this time, if the user clicks
the Item object within the left tree panel, the system uses the old data model of the
Relationship table which was already in the action context.

Resolution: Special handle Item objects, so that if the user clicks the Item object in the
left tree panel, the data model of the Item object should refresh first.

Verification:

1. Create P/N "Part01", attach file/s as attachment and release it to create rev A.
2. Assign Part01 to a new ECO . The current rev is B. Do not release this ECO.

3. Go to the Attachment tab of rev B. You can see the attachment file.
4

Click on part01 from the recently visited section. The user gets the Attachment tab
of rev A.

Result: The Attachment tab of rev A has dot and all the files are displayed.

21840078
Changes

Issue: ADDING REVIEWERS INEFFICIENT WHEN USER GROUPS ARE MORE
THAN 250

Root Cause: Cursor in an Iterator is at the last, making some code uncovered.
Resolution: Reset the cursor to the beginning.

Verification:

1. Create over 250+ User Groups with one user with reviewers privilege.
Create a Change Order and assign the workflow.

Change status to CCB.

Launch the palette for approvers.

o » ©Dbd

Select the Search within a User Group option and select a User Group:
UserGroup263.

Search for a user in UserGroup263 and return to the Change Status window.
Launch the palette for approvers/acknowledgers/observers.

UserGroup263 is listed in the drop-down list of search type.

© ®» N o

Close the Change Status window.
10. Open the Change Status window.
11. Launch the palette for approvers/acknowledgers/observers.

Result: UserGroup263 is listed in the drop-down list of search type.
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21888449
Mfr/Mfr Parts

Issue: SAVE AS MFR PARTS DOES NOT VALIDATE ALL MANDATORY
ATTRIBUTES, E.GMANUFACTURER

Root Cause: Save As MFR part does not check MFR Name.
Resolution: Check MFR Name when getting from UL
Verification:

1. Log in to Web Client as admin.

2. Create the new Mfr Part manually (not using Save As) with all mandatory fields,
for example:

Type: Manufacturer Part
Number: PW.0001-SCE
Manufacturer Name: AMD
3. Click on Actions > Save As.
4. Enter the mandatory attribute
Type: Manufacturer Part
Remove the value (AMD) for mandatory attribute Manufacturer Name
Number: PW.0002-SCE
5. Click Save.

Result: The following error message is displayed: "Please enter a valid
manufacturer name."

21980278
User/User Group

Issue: JOB FUNCTIONS TAB ERRORS WITH VOCELLLISTVALUE CANNOT BE
CAST TO VOCELLMULTILIST

Root Cause: FT.JF.User/UG attribute index is hard-coded as 2 in the code.
Resolution: Should get index as attribute id.

Verification:

1. Login to Java Client as admin.

2. Go to Classes > Functional Teams > Job Functions tab, disable attribute:Name,
then enable it again.

3. Login to Web Client as admin.

4. Go to Tools and Settings > Address book > Functional Teams, open any functional
team, then click its Job Functions tab.

Result: Job Functions tab opens successfully.

22081546
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Folders, Files & Attachments

Issue: SMARTLINK DOES NOT WORK CONSISTENTLY WHEN CREATED FROM A
NON-ENGLISH PROFILE

Root Cause: user profile did not load lang settings and the default value is English.
Resolution: when client lang setting is not correct, it will load user profile settings.
Verification:
1. Log in to Web Client.
2. Create a file folder.
3. Add files and check in.
4. Select a record and click Get Shortcut.
5. Copy the URL and paste in a new window.
Result: The file opens if the user selects it to open through the smart URL/link.

22087544
Notifications & Subscriptions

Issue: EMAIL TO ALL LOGGED IN USERS THROUGH JAVA CLIENT, IT SENDS TO
INACTIVE USERS

Root Cause: When sending an email to all logged in users, the system does not check
whether the user is inactive or not.

Resolution: Filter inactive users before sending email to all logged in users.
Verification:
Precondition: E-mail setting should work fine.
1. Do a Save As on the admin to new User, userO1.
2. Set the admin and user01 email with XX@oracle.com (use valid email address).
3. Login to Web Client as user01.
Result: User01 can log in successfully.
4. Close the web side of user01’s session. (Do not click the logout button.)
5. Login to Java Client as admin.
6. Go to email to users (under Analytics and Reports) and open.
7. Select All logged in users and enter "send" in the content.
8. Click Send.
9. Check the email. It sends the email with Agile System Notification to two users.
10. Go to Java Client and inactivate user01.
11. Go to the email to the users.
12. Openit.
13. Select All logged in users and enter "send" in the content.
14. Click Send.

Result: The inactive user does not receive the email again.

Resolved Issues 3-9
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22112072
Changes

Issue: MCO ARE NOT ABLE TO MOVE TO NEXT STATUS, WORKFLOW CRITERIA
NOT WORKING PROPERLY

Root Cause: Affected Item's required field checking logic is wrong.
Resolution: Correct the Affected Item's required field checking logic.
Verification:

1. Create two criteria: For example

MCOwithAltypepart:MCO Affected Items.Item Type In Part
MCOwithAltypeDocument: MCO Affected Items.Item Type in Document

2. Open Default Manufacturer Orders and go to the pending status.
3. Create two new criteria by using the new criteria:
One criteria with requires exit field Part.Page three.text01
Two criteria with requires exit field Document.Page three.text02
4. Make sure the Item type is enabled in MCO.ALI tab in Java Client.
5. Log in to Web Client as admin.
6. Create MCO, M001, with unassign status.
7. Add one Part, P001, and One Document D0001.
8. Both Items have no values in page 3 fields.
9. Assign one workflow to Attemp to change next status.
10. Filled in the values from required field hyperlink.
11. Save and change status.

Result: The change status can be changed successfully.

22112347
Roles & Privileges

Issue: "ADD TO TABLE" AND "DELETE FROM TABLE" DO NOT WORK AS
EXPECTED

Root Cause: When a user does not have modify privilege for Item.relationship.name
the user should be allowed to delete the relationship as long as the user has delete
from table all items priv with relationship table applied.

Resolution: Change the code’s logic.

Verification:

1. Login to Java Client as admin.

2. Create a new user:U001 with the following privileges:
--- Discover Items
-— Read Items

--- Create Items
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--- Modify Items (remove Items.Relationships.Name from applied to field)
-—- Add to Table All Item (Add Items.Relationships in the Applied to field)
-— Delete From Table all Items (Add Items.Relationships in the Applied to field)

3. Login to Web Client as U001.
4. Do a quick search of Items -->*, open some Items, such as P001, D001, P002.
5. Open P001, go to its Relationships table, an add D001 to this table by dragging
from recently visited panel.
6. Try to add another Item to the POO1.relatioship table by search: Items -->P002 or
create a new part:P003.
Result:
4. P001, D001 and P002 were displayed in Recently visited panel.
5. D001 can be added to P001.Relationships table successfully.
6. P002/P003 can be added to P001.Relationships table successfully.
22246064
Changes
Issue: USER IS NOT ABLE TO EXPORT THE WHERE USED TAB INFORMATION.
EXPORT UTILITY HANGS

Root Cause: The rev change id and rev change class are missing when executing
export, which makes the user unable to go through privilege check.

Resolution: Added rev change id and rev change class when submitting export
request in ITEMTABLE_ WHERELIST and ITEMTABLE. WHEREPENDLIS.

Verification:

1.
2

o o & W

Log in to Java Client as admin.
Create a User, user001, with the following privileges:

1) Discover Items - Latest Released Revision Only(Criteria:Items $LATESTREV Is
Released And Title Block.Lifecycle Phase Is Not Null)

2) Read Items - Latest Released Revision Only(Criteria:Items $LATESTREV Is
Released And Title Block.Lifecycle Phase Is Not Null)

3) Read Items - Read Only Users(Criteria:Items (
$CURRENTREV Equal To $STATUSTYPE.RELEASED Or
$CURRENTREYV Equal To $STATUSTYPE.COMPLETE ) And
$LATESTREYV Is Released)

4) Export

Log in to Web Client as admin.

Create Items P0001, P0002 and P0003.

Add P0003 to the Items 0001 and P0002's BOM tab.

Create a Change, C0001, and add the newly created Items to the Affected Items
tab.

Resolved Issues 3-11
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7. SetRev to A and Lifecycle Phase to Production, then release the change.
8. Loginto Web Client as User, user001.
9. Open the Item, P0003, and go to its Where Used tab.
10. Click More > Export button.
Result: The data on the Where Used tab is exported successfully.

22278675
Standard Reports

Issue: PAGE TWO ATTRIBUTES ARE NOT DISPLAYED ON ITEM
MANUFACTURING REPORT

Root Cause: The application does not correctly get P2 attribute. The combined key is
classID+attributelD, but there is some attribute id that equals this combined key.

Resolution: Change combined key as classID+"#"+attributelD to resolve this issue.
Verification:

1. Log in to Java Client, enable Parts Page Two, enable Page Two,, Text11,
MultiText31, Date01, MultiList01, Money01 and Numeric0l on page?2.

Log in to Web Client, create a new Part, P00011, and set each attribute in Page2.
Go to Manufacturer tab, add Mfr Part amd001.
Run the Item Manufactures Report.

One page 1 of the wizard, edit DEFAULT LAYOUT, add all Item.Parts.Page2
attributes.

a & 0N

6. On page 2 of the wizard, use Advanced Search to query out P00011:
Items.Parts.Object Search Number Equal To P00011.

7. On page 2 of the wizard, select all for list Preferred Status and Manufacturer part
Lifecycle Phase.

8. Click Finish to get the report.

Result: PageTwo attributes all have correct values.

22642747
Folders, Files, & Attachments

Issue: UNABLE TO GET THUMBNAIL: ORA-00942: TABLE OR VIEW DOES NOT
EXIST ERROR

Root Cause: According to error stack tracing, the table FS_ONETIME_
TRANSACTION_KEYS is not existing in the database.

Resolution: After running the SQL from HF30, the table is created.
Verification:

1. Enable thumbnails.

2. Create a new Part and add a .jpg file to the Attachments tab.

3. Modify the thumbnail preference on the user account.
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4.

Click on the new Part in Recently Visited list.
Result: No application error is displayed.

23549688

Relationships
Issue: ADD AVERIFY CASE FOR 23317450

Root Cause: Need a new Averify case to report missing Page Two/Page Three data
issue for User Group.

Resolution: Added an Averify test case to report miss Page Two/Page Three data
issue for User Group.

Verification:

Data Preparation:

1.
2

Prepare a fresh DB and link it to Agile. Log in to Web Client.

Tools and Settings > Address Book > User Groups. Add a new User Group named
UGO1.

Use sqldeveloper to connect that DB user to execute below SQLs: (A) select
id,class,name from user_group where name = 'UG01’; (get ID) (B) delete from
page_two where id = ID;ID got from(A) (C) delete from page_three where id =
ID;ID got from (A).

Steps:

1.

Set averify.properties. (a)averify.runOption=all
(b)averify.runOption=modules,averify.modules=pcp qm
(c)averify.runOption=tables,averify.tables=user_ group
(d)averify.runOption=testcases,averify.testcases =AGIL-00015006

Run Averify on that DB user.
Result: In oracle_averify_report.log, there should be error messages like below:

AGIL -00015006 : E : USER_GROUP table has bad data (ID XXX CLASS column
XXX is deleted from PAGE_TWO).

AGIL -00015006 : E : USER_GROUP table has bad data (ID XXX CLASS column
XXX is deleted from PAGE_THREE).

23594069
Folders, Files & Attachments
Issue: GETTING BLANK PAGE FOR THUMBNAIL

Root Cause: If some cookies have a null value, it blocks the thumbnail server
authentication.

Resolution: Filter out all null value cookies when doing authentication.

Verification:

Pre-Condition: In Java Client | Admin | Server Settings | Preferences | Thumbnail Support
should be set to enabled.

1.

Log in to Web Client.

Resolved Issues 3-13
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2. Create an Item.

3. Navigate to Attachments tab and add an image or a ZIP file or Microsoft Office
files or HTML or unsupported files OR add multiple files in a single file folder OR
add a URL.

4. Navigate to the Title Block tab and verify the Thumbnail.
Result: The thumbnail is displayed in the Item's Title Block tab.

24305185
Standard Reports

Issue: EXECUTING ATTRIBUTE HISTORY REPORT CREATES A ZERO SIZE FILE
INSTEAD OF HISTORY

Root Cause: When getting Rev Release Date attribute value while it is not enabled,
will

return -1 as attribute id and an array out of index:-1 exception will be

thrown.

Resolution: If Attribute Rev Release Date is not enabled, set release date to null
instead of getting its value.

Verification:

Preconditions:

1. Log in to Java Client as admin.

2. Disable Parts.Title Block.Rev Release Date.

3. Proper privileges for Part, ECO and MCO.

1. Log in to Web Client as admin.

Create 1 Part: PO001.

Create ECO & MCO against P0001, and route workflow to release.

Go to P0001, click Actions > Attribute History Report.

Select any layout and output format.

Click Next and finish.

Open Item_Attribute_History_Report.pdf with Adobe Acrobat Reader DC.

N o a » o Db

Result: Item_Attribute_History_Report can generate successfully.

24312344
Folders, Files & Attachments

Issue: USER CANNOT MAKE CHECKIN IN PRELIMINARY STATUS WITH
PENDING CHANGE FOR DOCUMENT

Root Cause: We do not transfer the info of Change when calling
getFileUploadFormData, so it fails to match some criteria when doing checkin.

Resolution: Transfer the changeclass and changeid when call getFileUploadFormData.

Verification:
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1. Login to A9 Web Client.

Create a Document

Navigate to the Attachments tab and add a file of File Folder/Design.
Create an ECO for Document.

Navigate to Attachments tab of pending Document.

Select the file and click on checkout, so that the file is downloaded.

N o a Db

Select the checked out file and click on Checkin so that File Replace Selector dialog
box appears.

Result: Click on the Browse for file and upload a file, so that the file is replaced
successfully.

24458295
User/User Group
Issue: FUNCTIONAL TEAM DETAILS DISPLAYED WRONGLY ON USER PROFILE

Root Cause: The function team of a user displays more FT when responding job
functions have many users that exceed maximum multiple list entry length. The server
has the wrong codes to fetch FT data.

Resolution: Correct the codes to get the FT data.
Verification:
1. Log in to web client as admin.

2. Import 210 users:933_u001 - 933_u210 to system, and add Job functions: QA lead;
Product strategy to all of these users

3. Create a functional team, FT001, go to its Job functions tab, and add job function,
QA lead with all 210 new created users

4. Open any user that displayed in Job function table such as, 933_u180, go to its
User Groups/Functional Teams tab, check displayed functional teams.

Result:
3. Job function: QA lead with all 210 new created users can be added successfully.

4. Only FT001 with related job function, QA lead, is displayed.

24491560

Performance

Issue: OBSERVING HIGH CPU UTILIZATION GREATER THAN 90%
Root Cause: Using String in a large loop creates many objects.
Resolution: Use StringBuilder in the loop.

Verification:

1. Ran load test for 25 concurrent users for 30 minutes for all frequently used actions
and monitored CPU usage through out the test.

Result: Confirmed that CPU utilization is normal.

Resolved Issues 3-15
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24799737
Item & BOM

Issue: ITEM WITH URL ATTACHMENT IS NOT SHOWING DOT ON
ATTACHMENT TAB OF ECO REDLINE

Root Cause: Cannot catch the warning messages when copying attachments of
Affected Item.

Resolution: Check Copy attachment warning before copying an Affected Item
attachments.

Verification:

1. Login to Java Client as admin user.

Set a Smart Rule: Copy Files To Rev-File Folders: Copy with Warning.
Log in to Web Client as admin.

Create a new Part, P001, then attach a URL to its Attachment tab.
Create an ECO, C001, against P001

Go to the Affected Items tab of C001, choose P001, check the redline attachment
tab.

o a & 0 N

Result: There is a dot on the Attachment tab.

24914666
Changes
Issue: ECR/DEVIATION REV COLUMN ISSUE

Root Cause: Class has not been checked before class casting, which leads to a
ClassCastException.

Resolution: Check class before casting.

Verification:

1. Log in to Web Client.

2. Create a Part, release it with several versions: A, B, C.

3. Create a Change Request or a Deviation, add the Part to the Affected Items tab.
4

In the Affected Items tab of the Change Request or the Deviation, click the
Revision cell of the Part.

Result: The cell is editable, all revisions are listed.

Product Cost Management
21946042

RFQ/Response

Issue: PCM ERROR: INSUFFICIENT PRIVILEGE TO VIEW RFQ WITH
AUTHORIZED USERS/OTHER USERS

Root Cause: Failed to add subclass ID to object and user created discover and read
RFQ privilege based on subclass level.
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Resolution: Added subclass ID to CMObjectID.

Verification:

1.

Log in to Java Client and create a Discover RFQ privilege with RFQ subclass level.

2. Create a Read RFQ privilege with RFQ subclass level.

3. Assign the Read and Discovery RFQ subclass privilege to rolel, and grant it to
user].

4. Create a Discover Authorized RFQ privilege with RFQ subclass level. Privilege
Criteria: RFQ CoverPage.Authorized Users Contains Any $USER.

5. Create a Read Authorized RFQ privilege with RFQ subclass level and above
criteria.

6. Assign the Read and Discover Authorized RFQ subclass privilege to role2, and
grant it to user2.

7. Disable the OOTB Read/Discover RFQs and Read/Discover Authorized RFQs
privileges with class level.

8. Loginto Web Client as user3, and create a Sourcing Project and add Items.

9. Open the Sourcing Project.

10. Create an RFQ, and edit the RFQ.Cover Page.Authorized User with user2.

11. Log in to Web Client as user1 and open the Sourcing Project.

12. View the RFQ in the Sourcing Project.RFQs tab.
Result: The other user (userl) can view the RFQ in the sourcing project’s RFQs tab
with discover and read RFQ privileges.

13. Do quick search with the RFQ number.
Result: The userl can also search out the RFQ.

14. Log in to Web Client as user2 who is Authorized on the RFQ. Open the sourcing
project.

15. View the RFQ in sourcing project. RFQs tab.
Result: The authorized user (user2) can view the RFQ in sourcing project. RFQs tab
with Discover and Read Authorized RFQ privileges.

16. Do a Quick Search with the RFQ number.
Result: The user2 can also search out the RFQ.

23487785

Standard Reports

Issue: MISMATCH IN MANUALLY CALCULATED VALUE AND REPORTED
VALUE IN ASSEMBLY COST REPORT

Root Cause: Material price adder attributes are not passed, so they are not included in
the total extended price.

Resolution: Invoke related method with material price adder attributes.

Verification:

1.

Log in to Java Client.

Resolved Issues 3-17
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2. In the Sourcing Project's Price Detail table, enable two material price adders, one
for supplier and the other for internal.

Log in to Web Client.
Create an assembly whose BOM Item has AML.

Create a Sourcing Project and add the new assembly.

3
4
5
6. Create an RFQ and open it to Suppliers.
7. Get aresponse from the Supplier.

8. Go to Analysis tab, select the Response line and apply price adder by Part.
9. Manually set this Supplier as best.

10. Execute Assembly cost report.

11. Apply price adder by commodity.

12. Manually set this Supplier as best.

13. Execute Effective Cost Comparison Report.

14. Apply price adder by Supplier.

15. Manually set this Supplier as best

16. Execute the Unit Cost Comparison Report.

Result: For steps 10, 13, and 16, all values of the reports are calculated correctly.

Product Governance & Compliance
14654981
Declaration

Issue: IF THE "DECLARED COMPLIANCE" VALUE IS NOT EXEMPT THEN
EXEMPTION AND EXEMPTION EXPIRATION DATE SHOULD BE DISABLED

Root Cause: Modifying Exemption Expiration Date does not check Declared
Compliance status.

Resolution: Check Declared Compliance Status when modifying Exemption
Expiration Date.

Verification:

1. Log in to Web Client as admin.

2. Create a Change Order, ECO001, then add a Part, P001, to its Al tab.
3. Navigate to Affected Item, P001, through change.
4

Add an existing specification, such as SP1 to P001.specification table, select any
value except exempt for Declared Compliance, such as Compliant, then modify
Exemption Expiration Date, and save it.

5. Click Cancel.

6. Reset Declared Compliance to Exempt, select a value for Exemptions and
Exemption Expiration Date, save it

Result:

4. Can’t save the modification, it prompts an error: Declared
Compliance/Exemption Expiration Date Values Mismatch: Only when the
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Declared Compliance is set to Exempt, should you select an Exemption Expiration
Date. Please resolve this issue.

5. P001 is refreshed and no value displayed for Exemption Expiration Date.

6. Can modify Exemption Expiration Date successfully when DECLARED
COMPLIANCE value is EXEMPT.

Product Portfolio Management
14605210
Administration/Configuration
Issue: SYSTEM ALLOWS TO CHANGE THE STATUS ON A LOCKED PHASE/TASK

Root Cause: Change status lock check is for root activity instead of an activity that is
being worked on.

Resolution: Added lock check for activity status change that is being is performed.
Verification:

1. Log in to Web Client as USERI.

Create a Phase, PHI1.

Add 3 tasks T1, T2 and T3 under phase PH1.

Task T1, T2 are complete.

Delegate task T3 to a user USER2 with team member role.

Lock the phase PHI.

Log in to Web Client as USER2 who has Team member role on phase PH1.

® N o g » 0 b

Change status of task T3 to Complete and check the status rollup on parent phase
PHI1.

Result: USER? is not allowed to change the status of locked task T3. Appropriate
error message saying "USER1 has explicitly locked the object T3 for update. Please
try again after the lock is released by USER1 or by unlocking T3." is displayed
when the user tries to change the status.

21910467
Content Management
Issue: CONTENT PAGE DOES NOT REFRESH WHEN ADDING FILE

Root Cause: The application does not refresh when files are added to the Content
table.

Resolution: Refresh the table after adding files.
Verification:

1. Log in to Web Client.

2. Create a Program.

3. Add files in the Content tab.

Result: The Content tab is refreshed.

Resolved Issues 3-19
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23252327
Export

Issue: PROJECT EXPORT GIVES ORA-00904: "T37"."RESOURCE_STATUS": INVALID
IDENTIFIER

Root Cause: When the user makes the Projects.Schedule.Resource Status attribute
visible and exports the PPM object to Excel, the column name corresponding to this
attribute, which is ACTIVITY.RESOURCE_STATUS, does not exist in the Activity
table. It is supposed to be ACTIVITY.RESOURCE_HEALTH.

Resolution: Correct the value from ACTIVITY.RESOURCE_STATUS to
ACTIVITY.RESOURCE_HEALTH.

Verification:

Preconditions: Log in to Java Client and navigate to Classes > Projects >Activities >
Schedule tab and enable the Resource Status attribute.

1. Log in to Web Client and create a Program with some child objects.
2. Go to Action > Export and click Export.

Result: The Program is exported as an Excel file and the exported file displays the
Resource Status attribute.

Product Quality Management

21550796
Java Client

Issue: AFFECTED ITEMS NAME MODIFIED FROM JAVA CLIENT IS NOT
REFLECTED TO WEB CLIENT

Root Cause: Get the display name from hard code.
Resolution: Get correct display name from the database.
Verification:

1. Login to Java Client as Admin.

2. Go to Admin > Settings > Data Settings > Classes > Quality Change Requests >
Corrective and Preventive Actions.

3. Go to User Interface tab > Affected Items.
4. Change name:
Affected Item(s) : Affected Items to Name Affected Items XX
5. Login to Web Client and create a new CAPA.
6. Go to the Affected Items tab. Check the Affected Item.
Result: The Affected Item name displays Affected Items XX.

Agile PLM Framework

3-20
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Event Java PX
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Issue: "NO PRIVILEGE" SHOWS IN EVENT HANDLER MONITOR
Root Cause: "NO PRIVILEGE" was inserted into event history table as object number.
Resolution: Do not insert "NO PRIVILEGE" as object number into event history table.
Verification:
Case 1:
1. Create two roles. test_role with privileges as follows:

Modify all Change Orders

Discovery all Change Orders

Read Change Orders exclude Title Block.Number

Enforce Field Level Read

2. Login to Web Client with one user who has the test_role role and trigger any
Event PX. Check if PX succeeds.

3. Login to Java Client as admin and include the privilege of Read Change Orders
Title Block.Number and check the Event Handler Monitor.

Result: The object number displays correctly in the Event Handler Monitor.
Case 2:
1. Create two roles. test_role with privileges as follows:

Modify all Change Orders

Discovery all Change Orders

Read Change Orders exclude Title Block.Number

Enforce Field Level Read

2. Login to Web Client as one user who has the new role, trigger any Event PX. See
PX succeeds.

3. Login toJava Client as admin user without privilege of Read Change Orders Title
Block.Number and check the Event Handler Monitor.

Result: No privilege is displayed correctly in the Event Handler Monitor.

20566624
Web Client

Issue: SAVEAS OF A CHANGE WITH SITE ENABLED AUTOMATICALLY FILL
OBSOLETE DATE

Root Cause: When doing a Save As on a Change Order with Affected Items, if Site is
added to the Item after the Change Order is released, at the same time, the obsolete
date is null, it is filled with the current date.

Resolution: If the Affected Item has no obsolete date, then let the user select it. If the
Al does have an obsolete date and the date is before the current date, the obsolete date
will be replaced by the current date.

Verification:
1. Log in to Web Client as admin.
2. Create a Part P00119, without a site.
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® N o o &

Create an ECO, C00059, and add the Item to Affected Items.
Set the new revision with A and effective date and save.
Release ECO C00059.

Add a Site to Part P00119’s Site tab.

Do a Save As on the released C00059 to C00106.

Check C00106’s Affected Items tab. The Site record has an effective date and
obsolete date.

Result: The obsolete date appears blank and can be edited.

20863155
Folders, Files, & Attachments

Issue: JAPANESE FILE NAME IN DOWNLOAD.ZIP IS CORRUPTED ON
DOWNLOADING MULTIPLE FILES OR MULTIPLE FILES IN A SINGLE FILE
FOLDER

Root Cause: File encoding issue.

Resolution: Fix in code.

Verification:

1.

Log in to Web Client on Mozilla or on IE11 with Document Mode as Edge.

2. Create an Item and navigate to the Attachments tab.

3. Add multiple Japanese files or multiple Japanese files in a single file folder.

4. Select multiple files or multiple Japanese files in a single file folder and click on
Get.

5. Unzip the download.zip file.
Result: The file names in download.zip file is not corrupted.

20958426

Web Client

Issue: LARGE TEXT ORDERING ISSUE
Root Cause: N/A
Resolution: N/A

Verification:

1.
2.

o o & W

Log in to Java Client as admin on F1 with pre-sales DB.

Go to Changes > Change Requests > Finance Documents > Attributes > Page
Three (had more 90+attributes)

Enable large text attributes.
Click the re-oder button.
Move up one of largetext into the top or others.

Click the OK button.
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7. Check the Page Three attributes.

Result: The largetext attributes are moved up successfully.

21188847

Web Client

Issue: CANNOT COPY AND PASTE FROM EXCEL ONTO AFFECTED ITEMS
Root Cause: N/A

Resolution: N/A

Verification:

1. Open the an Excel spreadsheet that contains multiple rows of items. Copy the
column range of Item numbers.

2. Login to Web Cient as admin.

3. Create an ECO.

4. Go to Affected Items.

5. Click Add, then CTRL V to paste.

Result: The values can be added successfully in IE/FF/Chrome.

21265268
Mfr/Mfr Parts

Issue: AVERIFY CHECK NEEDED FOR MANU_BY DUPLICATES WHERE
COUNT(PRIOR_ROW)>1

Root Cause: N/A

Resolution: N/A

Verification:

Data Preparation:

1. Prepare a fresh database and link it to Agile.
2. Login to Web Client.

3. Create a Part and a add a manufacturer. Create two ECOs (Change A, Change B)
for the Part.

4. Redline for manufacturer in both Change A and B.
5. Release Change A.
Steps:
1. set averify.properties.
(a) averify.runOption=all
(b) averify.runOption=modules,averify.modules=pcpgm
(c) averify.runOption=tables,averify.tables=manu_by
(d) averify.runOption=testcases,averify.testcases=AGIL-00060004
2. Run Averify on that DB user.
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Result: For the 4 runOption, in oracle_averify_report.log, there should be error
messages like below:

AGIL -00060004 : E : MANU_BY table has bad data (ITEM ID XXX PRIOR_ROW
column XXX has duplicates on release changes.)

21865894

Web Client

Issue: LARGE TEXT FIELD CANNOT BE RE-ORDERED
Root Cause: N/A

Resolution: N/A

Verification:

1. Login to Java Client as admin.

2. Open a sub class like parts.page Two.
3. Enable LargeText field.

4. Move the new attribute up.

5. Click Ok.

Result: The LargeText attributes are saved successfully with the new sort order.

21923921
AUT

Issue: AFTER UPGRADE FROM AGILE 9.3.1 TO 9.3.4 ITEM ATTACHMENTS TAB IS
MISSING

Root Cause: This is an AUT bug. The fix requires that the customer upgrade again
from 931 to 933 with the fixed script, but the data after 933 will lost.

Resolution: Use the fixed script.

Verification:

1. Log in to Java Client or Web Client.

2. Open Item, P03673, and click the Attachments tab.

3. Verify Filename, File Description, File Size and File Type.

Result: The Filename, File Description, File Size and File type are displayed
appropriately.

21984096

Import

Issue: GETTING FATAL ERROR WHILE IMPORT BOM WITH EFFECTIVE DATE
Root Cause: Null point exception.

Resolution: Modified code to avoid the exception.

Verification:
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1. Launch the Import wizard in Web Client.
Select Import file: test.xIsx.

Choose Template Type: Level template

P w N

Modify Preferences as below:

Parsing and Validation Multilist Delimiter Character: semicolon (;)
Cascade Delimiter Character: Vertical bar (1)

Whitespace Validation Action: Strip

Case Validation Action: Convert Length Validation Action: Truncate
Blank Data Action: Retain Data Business Rule

Smart Rules Warning Violation Behavior: Accept objects

Reference Designator Quantity Mismatch Behavior: Accept
Behavior upon non-existing objects: Accept

Change Mode: Redlining

Redline Mode Behavior: New /Redlined items onto the change
BOM & AML import behavior: Import assys, amls and component
Multi Row Update Mode: Complete Replace

Click Save and then click Next.

Select the saved mapping file: NewMapFile_5_.xml

Create or search for a change for Redline Option and click Next.

© N o

Click Import and check the message in the Import Log

Result: The file is imported successfully without fatal error in the Import Log.

22198042
Web Client
Issue: LIST DISPLAY CHANGED FROM LIST TO SEARCH

Root Cause: When list record size is greater than Maximum List Values Displayed that
was set on the admin side, Agile switches the Ul control from list to search, as well as
display type of the list in the cache.

Resolution: Block auto switch from Ul, especially on the title block, grid table and
search. Enable the ability to manually change and save display type via Java Client.

Verification:
1. Login to Java Client as admin.
2. Click Admin > Data Settings > Lists.

3. Click the New button and input List Name=L001, set List Type = Simple and
Display Type =List, then click OK.

4. Add more than 300 entries for the list, LOO1.

5. Click Admin > Data Settings > Preference, set the preference Maximum List
Values Display to 300’.
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6. Open Class > Parts and enable a list, List01, on Page Two and point to list, LO01.
7. Login to Web Client as admin.
8. Create a Part, P001, and go to List01 on Page Two.

Result: List01 on Page Two displays as list not search.

22309209
Custom Reports

Issue: CUSTOM REPORT LAYOUTS CANNOT BE OPENED IN REPORT PALETTE
UNDER ITEM MANUFACTURER REPORT

Root Cause: If the Report layout list contains more than 10 values, the issue occurs. It
uses default batch size 10 as list range for all situations and causes this issue.

Resolution: Reset the range when loading the report table.

Verification:

1. Log in to Web Client, find Item Manufacturer Report.

2. On the Layout tab, create more than 10 custom layouts, for example, test1 - test12.
3. Click the name of the bottom layouts, like test10 - test12.

Result: There is no error.

22334568
Event Java PX
Issue: PATCH 18795976: 9.3.3.0.74 DOESN'T WORK

Root Cause: The wrong changeKey is sent to the process extension code. In
CMSessionBean.java, after the fix of PATCH 18795976: 9.3.3.0.74, reset the wrong
values in request.

Resolution: If using drag & drop, do not set the wrong values in the request.
Verification:
1. Create Event Event Type: Update table
Object Type: Change Order
Table name: Affected Items
2. Create Event Handler with the following code:
IUpdateTableEventInfo info =
(IUpdateTableEventInfo) eventInfo;
IChange parent = (IChange)
info.getDataObject();

Iterator iter =

info.getTable().iterator();
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while (iter.hasNext())

{

IEventDirtyRowUpdate element =
(IEventDirtyRowUpdate) iter.next();

[Ttem child = (Iltem)

element.getReferent();

if(child == null){

System.out.printIn("child is null");

Jelse{

System.out.println("child is not null");
System.out.println( "

HHHAAAA Action=" + element.getAction());
if (element.getAction()

==0)

{

System.out.println(

"H#iHHAAARA# add action##H );
System.out.println(

"HHHHHHHEE size” + child.getValues());

System.out.println('@@@@@@@@@@Item number
="+child.getValue(new Integer(1001)));

}

}

3. Create an Event Subscriber with the event & event handler. from step 2

4. Login to Agile Web Client. Drag and drop an item to a Change Order's Affected
Items tab.

Result: The action completes successfully.

22334923
Standard Reports

Issue: BOM COMPARISON REPORT IS BLANK WHILE RUNNING IN FRENCH
LANGUAGE

Resolved Issues 3-27
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3-28

Root Cause: The BOM Comparison report does not handle special characters when
generating XML files.

Resolution: Handle XML special characters.

Verification:

1. Log in to Web Client as admin.

2. Go to My Settings > Preference, set language to French and log out.
3. Loginto Web Client as admin.
4

Rapports -> Rapports Standard -> Rapports de produit -> Rapport de
comparaison des nomenclatures (BOM Comparison Report).

L

Execute the report, choose 'word' format in the 'Format de sortie' area.
6. Go through the report wizard, check the output report.

7. Repeat steps 5~6 with Excel/HTML format.

Result: The report works properly.

22557810
DB Upgrade/AUT

Issue: AVERIFY ERROR AGIL-00025020,AGIL-00025036 HAPPENS ON PDCS DUMP
AFTER UPGRADE

Root Cause: Bad data in adminmsatt table due to some out-of-box privileges being
deleted in nodetable.

Resolution: Delete bad data in adminmsatt.
Verification:

1. Import the 934 PDCS dump file.

2. Run AUT 1.7.7 to upgrade the database to 935.

3. Go tologs\averifylogs\9.3.5 and check if there are any errors in the oracle_
averify_report.log.

Result: No error is introduced after the upgrade.

22580429
Searches

Issue: INCORRECT ERROR MESSAGE WHILE TRYING TO USE GO TO OPTION
UNDER BOM

Root Cause: The message is not correct for the Go To Item BOM popup windows.
Resolution: Fixed and changed the message to "No Item matching the Search Criteria."
Verification:

1. Log in to Web Client.

2. Create a Part, P0001, and go to the BOM tab.

3. Click the Go To button.
4

Enter a value and press the Find Next button.
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Result: It displays the error message "No matches were found for the specified
levels."

22695394
Web Client

Issue: CERTIFICATION OF MICROSOFT WINDOWS 10, IE11 AND EDGE
BROWSERS ON PLM 9.3.4

Root Cause: Agile PLM 9.3.4 did not support IE11 and Edge browsers on windows10
0s.

Resolution: Support IE11 and Edge browsers on windows10 OS in Agile PLM 9.3.6.
Verification:

1. Log in to the windows 10 OS.

2. Open 9.3.6 product's Web Client within Edge or IE11 browsers.

3. Check the UL

4. Do some function checks.

Result: The values appear correctly and basic functions work fine with Edge and
IE11 browsers.

22721697
Web Client

Issue: DIFFERENT BEHAVIOR WHEN ENTERING SINGLE/DOUBLE BYTE SPACE
ON TEXT/MULTITEXT

Root Cause: Two bytes space (typically used in Japanese, and Unicode is \u3000) is
not trimmed.

Resolution: Trim two bytes spaces(\u3000).
Verification:
1. Login to Java Client as admin.

2. Set the following Page Three. MultiText30 atrributes to yes Name : MultiText30
Include Characters : All Characters with space and Mixed Case Required : Yes,
save it

3. Login to Web Client and open an object with Page Three. MultiText30 attribute.
4. Enter double byte space " " to the Page Three. MultiText30 field and save.

Result: A message pops up with "MultiText30 is a required field." The space is
trimmed now.

22752236
Administration/Configuration

Issue: TRANSFER AUTHORITY GETS COMPLAINT ABOUT THE START DATE FOR
GERMAN LANGUAGE

Resolved Issues 3-29



Agile PLM Framework

Root Cause: For German language, when displaying the Create/Edit Transter
Authority page, the timezone id is set to U.S. locale, not the locale of the current user,
which causes a parsing error when saving it.

Resolution: Set the time zone id to the current user's locale, not the U.S. locale.
Verification:
1. Log in to Web Client as admin.

2. Create a new admin user, u001, go to its Preference tab, set its Language as
German, Time Zone as (GMT+01:00) Berlin.

3. Login to Web Client as u001.

4. Click my Settings > Transfer Authority, try to create a Transfer Authority, enter
values for all required fields containing start date and end date, then save it.

Results: The user can create TA for German User successfully.

22824681
Web Client

Issue: WEB CLIENT PAGE BLANKS OUT BY EXPANDING NAVIGATION PANE
AFTER RESIZING WINDOW

Root Cause: When collapsing the left pane, Agile backs up the width of the main pane,
and restores it when expanding the left pane. In the case reported in this bug, the
width of main pane already changes, which is the issue.

Resolution: When expanding the left pane, recalculate the width of main pane.
Verification:
1. Login to Web Client with IE11 and FF browsers.
2. Click Restore Down to change the window size.
3. Collapse Left Navigation.
4. Click Maximize Window.
5. Expand Left Navigation
Results: There is no blank page on the Web Client with IE11 and FF browsers.

22884300
Searches
Issue: ADVANCED SEARCH NOT SHOWING CORRECT RESULTS

Root Cause: When searching for the workflow.approver, Agile needs to join
workflow_process table and get state_code in (0,1) to filter historical approver info.

Resolution: Join the workflow_process table to identify real approvers for changes.
Verification:

1. Login to Java Client as admin.

2. Go to System Settings > Smart Rules, set Demotion Reviewers removal as remove.

3. Login to Web Client as admin.
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4. Create a Change Order, ECO001, with workflow, Default change orders, then route
it to CCB status with approver as admin.

5. Roll back to Pending status.

6. Do an Advanced Search: Changes > Workflow.Approver Contains, click the
prompt box and Workflow.Signoff User Dose Not Contain, click the prompt box,
and save it as S1, then run the search.

7. Input admin as search criteria for both fields, run the search.

8. Route ECO001 to submit status again, run the saved search S1, and input admin
as search criteria for both fields, run the search.

Results:

6. Enter Search Values window is prompted.
7. ECO001 is not in search results.

8. ECOO001 is not in search results.

23029108
Web Client

Issue: LOADING PROGRESS ICON KEEPS RUNNING EVEN THOUGH DATA
LOAD HAS COMPLETED

Root Cause: Inbox.jsp

AGILE.EventManager.addEvent(RIGHTPANECONTENT, ON_LOAD, function() {
doInboxOnloadActions();
if(dashboardLoadActions) dashboardLoad Actions();

Di

DashboardExecutiveTab.jsp

AGILE.EventManager.addEvent('content_view', ON_LOAD, function() {
dashboardLoadActions();

h;

Inbox.jsp calls dashboardLoadActions, but actually this page is used by Notifications,
Workflow Routings and My Assignments, in these pages function
dashboardLoadActions should not be called, so there is script error.

Resolution: Try any exception in layout.js:
AGILE.EventManager.fireEvent(this.container.id, ON_LOAD, fireArgs);
Verification:

1. Log in to Web Client.

2. Click the Home button and move to Notifications, Workflow Routings, and My
Assignments tab.

Result: The loading progress icon on the upper right corner disappears when the
data is finished loading.
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23633902

Web Client

Issue: CAN'T PASTE ALL COPIED DATA

Root Cause: AC type ahead functionality behavior:
1. Type in a keyword.

2. Server returns values that match the keywords.

3. If server returns only one value, the value will be selected, if server returns multiple
matched values, none of the values will be selected. For example, there are several
values: valueX, valueXX, valueXXX, valueXXXBB, if the user types in keyword 'value’,
four values will be returned, if the user types in keyword 'valueXXX', two values will
be returned, if the user types in keyword 'valuesXXXB', only one value 'valueXXXBB'
will be returned and it will be selected.

There is a little functionality defect: if a user types in valueX, although four values will
be returned, but actually there is a value 'valueX' which is exactly match the keyword,
it should be selected.

Resolution: Even if the server returns multiple values for a keyword, if one of the
returned values exactly matches the keyword, it should be selected.

Verification:

1. Log in to Java client to add below list entries to ProductLin list and save it.
Grapple
Grapple-C
Sideswipe
Sideswipe-C
Sideswipe OEM
Steeljaw-M
Steeljaw-M Plasma
Soundwave
Soundwave OEM

2. Login to Web Client to create a Change Order and populate the required fields for
creation.

3. Copy Step 1 list values from notepad: Grapple; Grapple-C; Sideswipe;
Sideswipe-C; Sideswipe OEM; Steeljaw-M; Steeljaw-M Plasma; Soundwave;
Soundwave OEM

4. Navigate back to the new Change Order and click the Edit button.
5. Paste the values into the ProductLine field.
6. Click the Save button - review the pasted result.

Result: All 9 values keep in ProductLine field.

24007652
Event Java PX
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Issue: CANNOT FIND ANY SUBSCRIBER IN EVENT SUBSCRIBERS TAB OF
DOCUMENTS CLASS

Root Cause: The following 2 classes are not packaged into pcserver.jar:
com/agile/admin/server/HistoryRecordable.class
com/agile/admin/server/ ADNodeAssign.class

Resolution: Added the 2 classes into usedejbclasses.txt to ensure that the 2 classes will
be packaged into pcserver.jar.

Verification:

1. Create any type of Event Subscriber for any class. For example, the Documents
class.

2. Open Classes > Documents > Event Subscriber ST-tab, select Show All.

Result: The Configured Event Subscriber is shown.

24306125
Export

Issue: EXPORTING PROJECT RESULTS IN JAVA.LANG.NULLPOINTEREXCEPTION
ERROR

Root Cause: A mistake of using the "And" operator, use "&&", not "&".
Resolution: Change "&" to "&&".
Verification:

1. Login to Web Client as user A.

2. From the Home screen select Tools and Settings > Export.
3. Leave Format as Excel.
4. Click Add.
5. Execute search for Program (Device), Project.
6. Select "ABASIN-27".
7. Click Next.
8. Output Filter > Create custom Filter.
9. Click Next.
10. Custom Select Content > Select All
11. Click Next.
12. Click Export.
Result: Export occurs successfully with correct result.
24311793
Import

Issue: IMPORTING SPECIFICATION OBJECT GET A WRONG NAME
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Root Cause: To support upper/lower/mixed case, the method
createRealObjNumberCollection of super class BatchHandler.java should be
overwritten, but the specification handler does not overwrite it.

Resolution: Overwrite the method 'createRealObjNumberCollection' to support
upper/lower/mixed case when creating specification.

Verification:

1. Prepare data in a source file to import. Input the value for Specification Name with
mixed case.

Log in to Web Client, and run Import.
Select the file created in step 1 for Import File.
On the Specify File Content screen, select Specification | Specification only.

Define the attribute mapping.

o g & 0 b

Run Import. Check the imported specification.

Result: Specification Name is created in its original case, instead of all upper case.

24365011
Averify Issues
Issue: ADD AVERIFY CASE FOR 24334009

Root Cause: There is no case to verify if this user is still used as an owner in the User
Group when the user is deleted permanently.

Resolution: Add a new case to check whether a user is still used as an owner in a User
Group when it is deleted permanently.

Verification:
Data Preparation:
1. Start Agile and log in as admin.

2. Create a new user, testsla, and create a User Group and add the new user into the
User Group. Make sure the user is owner of the User Group.

3. Login as DB user with sqlplus and execute below SQLs:
select id from agileuser where loginid = 'testsla’;
delete from agileuser where loginid=id;(got from above)
Steps:
1. Set averify.properties.
(a) averify.runOption=all
(b) averify.runOption=modules,averify modules=com mon,ppm
(c) averify.runOption=testcases,averify.testcases =AGIL-00028000
2. Run Averify on that DB user.
Result: In oracle_averify_report.log, there should be error messages like below:

AGIL -00028000 : E : USER_GROUP table has bad data (User ID XXX has been
deleted. But owner of user group XXX is still there.)
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24365645
Folders, Files, & Attachments

Issue: AFTER APPLYING 9.3.5.0.11 CHECKOUT FOR FILE FOLDERS PRIVILEGE
DOES NOT WORK

Root Cause: After 9350.11, Agile does not check checkout privilege by object type. This
is a code defect.

Resolution: Check the checkout privilege by object type.
Verification:

Preconditions: In Java Client, User docm has 'Component Engineer’, Folder
Administrator and 'Design Engineer' roles. Privilege 'Checkout for unreleased Items' is
enabled and granted to the 'Component Engineer' role along with other privileges and
Privilege 'Checkout Designs' is enabled and granted to the 'Design Engineer' role along
with other privileges. Privilege 'Checkout File Folders' is enabled and granted to the
'Folder Administrator' role along with other privileges.

1. Log in to Web Client as docm user.

2. Create a Design/File Folder, add single or multiple files and checkin.

3. Create a Part, Navigate to Attachments Tab and add the Design/File Folder.
4. Access Design/File Folder object and verify the Checkout button.
5

Access the Item object, navigate to the Attachment tab, select the file and click on
Checkout .

6. InJava Client, disable the privilege 'Checkout for unreleased Items' granted to the
'‘Component Engineer' role.

7. Log out and log in to Web Client as docm user.
8. Access Design/File Folder object or Quick View and verify the Checkout button.
Result: The Checkout button is active for Design/File Folder object

24407139
Averify Issues
Issue: ADD AVERIFY CASE FOR 21540894

Root Cause: There is no case to verify if data still exists for user related field of
workflow status/criteria in adminmsatt table when a user is deleted permanently.

Resolution: Add a new case to verify if data still exists for user related field of
workflow status/criteria in adminmsatt table when a user is deleted permanently.

Verification:

1. Set averify.properties.
(a)averify.runOption=all
(b)averify.runOption=modules,averify.modules=common
(c)averify.runOption=tables,averify.tables=adminmsatt
(d)averify.runOption=testcases,averify.testcases=AGIL-00028001

2. Run Averify on that DB user.
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Result: In oracle_averify_report.log, there is an error messages as follows:

AGIL -00028001 : E : ADMINMSATT table has bad data (Missing adminmsatt data
reference at User ID XXX)

24494674
Web Client
Issue: FAIL TO SYNC USER FROM AGILE TO RMW

Root Cause: Agile 9.3.6 introduced a new number format, but the integration
properties did not change with admin meta data.

Resolution: Update integration properties with new meta data.
Verification:

1. Make sure Agile-RMW Web Service Integration is configured.

2. Login to Agile Web Client.

3. Go to Address Book > Users, create a new user, give it all Roles, save.
4. Go to History tab.

Result: The use is synchronized to RMW successfully. In RMW, this user can be
searched out.

24502403
Folders, Files, & Attachments
Issue: CAN NOT CHECK IN MULTIPLE FILES FOR PART WITH REVISION

Root Cause: Introduced this bug by 935. This is a code defect. We do not correctly
handle file upload in the Item Files tab.

Resolution: Handle Item Files tab the same as in 934.

Verification:

1. Log in to Web Client.

2. Create Item P00066, and add two attachments.

3. Add Item P00066 to Change C00044, and release with revision 01.

4. Open revision 01 of Item P00066, and checkout attachments A.txt and B.txt.
5. Check in attachments A.txt and B.txt.

Result: File check in occurs successfully.

24511051
Web Services
Issue: HOW TO SEND THE OBJECT IN MICROSOFT C#

Root Cause: In this case, the client needs to send the class and object information to
the server. The XSD schema definition AgileUserUserGroupldentifierType, C# strictly
follows the limitation for choice type that prevents you from setting classldentifier and
objectldentifier at the same time.

3-36 Agile Product Lifecycle Management Readme



Agile PLM Framework

Resolution: Correct the definition AgileUserUserGroupldentifierType as sequence
instead of choice type. This way, Java and C# both can set classldentifier and
objectldentifier at the same time.

Verification:

1. Access the
http:/ /hostname:portnumber/CoreService/services/BusinessObject?xsd=1

2. Verify that AgileUserUserGroupldentifierType has now been changed to
<xsd:sequence>.

3. The AgileUserUserGroupldentifierType has been changed to sequence so that
Class identifier and Objectldentifier can be set at the same time.

Result: AgileUserUserGroupldentifierType has now been changed to
<xsd:sequence>.

24554823

Averify Issues

Issue: ADD AVERIFY CASE FOR 24339072

Root Cause: N/A

Resolution: N/A

Verification:

Preconditions:

1. Create a database user and import a demo database.

2. Log in to sqlplus on DB user and execute the following SQLs to create bad data:
(a) insert into user_group (id, name,enabled,delete_flag) values ('2000', UG01','1','1");

(b) update agileuser set delete_flag=1 where loginid="test01'; (choose a user to set its
delete_flag to 1)

(c) select id from agileuser where delete_flag=1 union select id from user_group where
RN-delete_flag=1;

(d) insert into adminmsatt (parentid,attid,value) values (22820,230,2000); (attid in
230,208,213,218,219,257, value in result of (c))

(e) commit; .
1. Set averify.properties.
(A) averify.runOption = all;
(B) verify.runOption = modules. averify modules = pcpqm;
(C) averify.runOption = testcases. averify.testcases = AGIL-00015007
2. Run Averify on that DB user.
Result: In oracle_averify_report.log, there is an error messages like below:

AGIL -00015007 : E : ADMINMSATT table has bad data (ATTIDXXX VALUE
column XXX is marked as delete in table AGILEUSER/USER_GROUP.)
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20911872

EC Services

Issue: INITIAL SAVE MAPPING FOR DESIGN.TITLEBLOCK.COMPONENT TYPE IS
NOT WORKING

Root Cause: From the fiddler, the value of component type is sent to ECS when
creating a design object, however, the server side ignored this value and did not save

it.

Resolution: Make sure the value of component type is updated correctly when
creating the design object.

Verification:

1.
2.
3.

10.
11.

Open Solidworks and login Preference.
Open Mapping Editor.

In Ithe nitial Save tab and Update Save tab, add mapping for Design.Title
Block.Component Type then save.

Create a Part from File > New and save it locally.

Select the CAD file in Model Tree then click File > Properties. Then Add properties
for Design.Title Block.Component Type and set some values for them.

Click Agile -> Save Preview button, double click the component will bring up edit
properties table, Design.Title Block.Component Type can display with correct
value.

Click Continue and open the object from the save summary window.
In Agile Web Client, check the value of Design.Title Block.Component Type.
Result: Component type is displayed with the correct value.

In the CAD system, select the CAD file in the Model Tree and click File >
Properties.

Result: Component Type is displayed with the correct value.
Click Agile > Save preview and click Continue.
Log in to Agile Web Client and check Design.Title Block.Component Type.

Result: Design.Title Block.Component Type is displayed with the correct value
under version 2.
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Known Issues Introduction

This chapter contains a list of known issues for this release. These were deferred from
this release, but may be fixed in a future release. Numbers in this section are for Oracle
Agile internal use only.

Known Issue Disclaimer

This list of Known Issues consists of those found at the time of the initial release. The
product may have additional issues found after the initial release and therefore this list
is subject to change and is not always comprehensive. Oracle support will continue to
track known issues of this product release found on My Oracle Support. Please check
for updates at https://support.oracle.com.

23343223
Sourcing Project

Issue: TOTAL MATERIAL PRICE IS INCORRECT WITH DECIMALS AFTER
MULTIPLIED BY QPA

Steps to Reproduce:

1. Create an Assembly as follows:

Assembly001

Child1 (QPA: 1)

Child2 (QPA: 2)

Add the Assembly to a Sourcing project.

Open the Sourcing Project.

Create an RFQ and add the Assembly, then assign it to a supplier

a0 Dbn

Get responses from the supplier with prices as follows:

Assembly001 NMP:2

Child1 MP:5.1

Child2 MP: 5.1

6. Go to the Sourcing Project, do Rollup Cost Report from the Actions menu.
7. Verify the prices in the report.
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Actual Result: For the assembly, the calculated Total Materials Price is
15.299999999999999.

Expected Result: The calculated Total Materials Price should be 15.3 (5.1+5.1*2).

Workaround: N/A

23532099
Folders, Files & Attachments

Issue: FILE FOLDERS SUBSCRIPTION URL ALWAYS TAKES TO THE LATEST
VERSION

Steps to Reproduce:

1.

® N o g » 0 b

Log in as userl.

Create a File Folder/Design.

Bump up the versions to 3-4.

From the Actions menu > Subscribe, select File Options - View /Open and Get file.
Log in as another user, search for file folder/design.

Select version 1 or 2.

Perform Get/View and Open actions.

Log in as userl, and select the notifications triggered for the view, get and open
actions.

Select Access URL from notifications.
Actual Result: Always takes the user to the latest version of the folder.

Expected Result: It should take the user to version 1 or 2 (whichever was specified).

Workaround: N/A

24571104

EC Services

Issue: WHEN ENABLE STREAMING FILE, AUTOVUE CANNOT LOAD ASM FILE
IN DRW VIEW WINDOW

Steps to Reproduce:

Preconditions:

1.

Start up the testing server with AutoVue Client applied and connected to AutoVue
Server. (In Java Client > Setting > Server Settings > Location, check the Enable
Pre-generation by Vue Server option and type in the correct Vue Server Host and
Vue Server Port).

In Java Client > Preference setting, set the Thumbnail and streaming file
pre-generation as enabled.

In Java Client > Preference setting, set Generate Mobile Viewing Files as Yes.

In Java Client > System Settings >Viewers & Files > File association, check the file
types - drw/asm/prt in the Viewer column, CAD Structure column and do not
check the Auto generate thumbnail column and 3D Viewable column.
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Steps:

1. Launch CAD system, and click Agile > Preference to log in to Agile.

Open the testing file: staff_and_rings.drw.

Click Save Preview.

Select all components, and click Save As button to generate design number.
Click Continue to save all the components to Agile.

Log in to Web Client, open the Root Design object which was saved in Step 4.

From the Files tab, select the .drw file and click View > View button.

® N o g »~ b

Launch AutoVue successfully, and click the ASM file in the View window.
Actual Result: Cannot load .asm file, it pops up an error message: "File not found".

Expected Result: It should load the view of .asm file successfully. Note: If the user
unchecks "Enable Pre-generation by Vue Server" in Java Client > Setting > Server
Settings > Location, the .asm file loads successfully in the view window of .drw.

Workaround: View the assembly file directly.

24603084
Main Install

Issue: UNABLE TO STARTUP MANAGED SERVER AT FIRST TIME AS
JPSCONFIGURATIONEXCEPTION

Steps to Reproduce:

1. Set Agile Clustered env. Admin + Managed server in one server, with the
managed server in another one.

2. Try to start all Admin + Managed Servers
Actual Result: All the servers can start successfully.

Expected Result: Unable to start Managed Server only at first time as JPS
configuration exception&#12290;

Workaround: Start the managed server again.

24700177
EC Services

Issue: DESIGN P2 NEW ENABLED OOB ATTRIBUTE VALUE IS NOT RETURNED
ON LEFT DETAILS PANE

Steps to Reproduce:

1. Log in to Java Client and enable one OOB P2 attribute for design, for example,
Design.P2.MultiText45.

2. Assign the Read and Modify privilege on the new enabled attribute of Design, P2,
make sure the read privilege criteria is based on the Design subclass, but not class
level. This is a key Step. If the read privilege criteria is at the design class level,
then the design P2 attribute value can be returned properly by RDS.

3. Launch the CAD tool and connect to Agile.
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Create a new CAD file and click Save Preview.

Set the value for Design.P2.MultiText45 on left details pane by Edit Properties.
Click Continue to save to Agile.

Result: The attribute value is set properly on design P2 from Agile Web Client.
Click Save Preview again.

Check the value of Design.P2.MultiText45 on the left details pane by Edit.

Actual Result: The attribute value on the left details pane is blank although it is set
properly in Agile.

Note:

1. This issue happens on the newly enabled design p2 attribute. For existing
enabled attribute on design.P2, the value is returned properly.

2. This issue only happens on design P2. For design.P3, item.P2 and item.P3, there
is no such issue.

3. This issue is fine on 934, failed since 935.

Expected Result: The newly enabled OOB attribute value for design.p2 should be
returned successfully on the left details pane by Edit Properties.

Workaround: Create the Read privilege with privilege criteria based on design class
level to include the newly enabled P2 attributes in the applied to list.

24901415

EC Services

Issue: IT DOES NOT DISPLAY AS REDLINE ADDED WHEN SAVING ATTRIBUTE
ON A CHANGE FROM MCAD

Steps to Reproduce:

1.

10.

In Java Client, enable the following attributes and set them as change controlled:
Parts.Title Block.Part Category and Product Line

Parts.Page Two.List18, Multilist01, Text02, Multitext35 and Numeric06
Parts.Page Three.Text01, Multitext10, List01, Multilist03 and Numeric01

Launch CAD system and log in to Agile via workspace manager.

Open Preference tab, set "Save As" with value "Item and Design".

Open Mapping Editor > Initial Save, add the attributes enabled in Step 1 to Initial
Save tab and set Parameter for these attributes.

Create or Open a testing Part model, Partl.sldprt, in this case.

Open File > Properties, in Custom tab, add properties for the attributes enabled in
Step 1.

Click Agile > Save Preview.
Highlight the component and click the Save As button.

Create a Change Order, C001, and assign it to the Item by selecting Assign Change
from the context menu.

Click Continue in Agile save preview.
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11. Log in to Web Client, open C001, and check the Redline Title Block table.

Actual Result: The attributes are saved successfully, but are not displayed as redline
added.

Expected Result: The attributes enabled in Step 1 should display as redline added.
Note that this issue also exists in 9.3.5

Workaround: There is no workaround from EC MCAD. The user can do a redline from
Web Client and then it can display correctly.

25059787
Workflow

Issue: DISPLAY WARNING MESSAGE IF THE ENTRY REQUIRED FIELDS ARE
FILLED IN COVER PAGE

Steps to Reproduce:

1. Login to Java Client as admin.

2. Enable Change Orders.Page Two.Text01 and ECO.Page Three.Text01.

3. Grant Read/Modify privilege on the two newly enabled attributes for the user.
4

Set Default Change Orders.Pending.Entry Required Fields: Change Orders.Cover
Page.Product Line(s), Change Orders.Page Two.Text01, ECO.Page Three.Text01.

a

Log in to Web Client as admin.
6. Create ECOOL.

7. Set workflow: Default Change Orders, set values for 3 entry required fields from
Step 4.

8. Click Save.
9. Check whether there is any warning dialog about missing entry required fields.

Actual Result: Displays warning message: "The following Entry Required fields to
Pending status are missing : [The following required fields are missing: ECO01:
Page Two.Text01, The following required fields are missing: ECOO01: Page
Three.Text01]. Would you like to continue?"

Expected Result: There should be no warning about missing required field shows. It
can be saved successfully and status should be in Pending.

Workaround: In Step 7, set and save values for the above 3 entry required fields first,
and then set and save Default Change Orders for workflow fields.

25088189

Directory Access Protocol

Issue: LDAP NODE AFTER CONFIGURATION IS THROWING SOCKET ERROR
Steps to Reproduce:

1. Set up an app server in the United States and an LDAP server in India (high
latency between these two servers).

2. Configure an LDAP Node in Java Client.

Actual Result: Sync and Refresh Users throws a socket error.
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Expected Result: There should be no such error.

Workaround: Override the default timeout (60sec) and max message size (10MB)
value by adding the following runtime parameters when starting Java Client:

-Dweblogic.CompleteMessageTimeout=480 -Dweblogic.MaxMessageSize=30000000

25102160
Folders, Files, and Attachments

Issue: ATTACHMENTS, FILES, REDLINE ATTACHMENTS TABLE NOT AUTO
REFRESHED ON REDLINING THE FILES

Steps to Reproduce:

Preconditions: Enable Attachment Redlines privilege for all objects for self/others in
Java Client.

Steps:
1. Log in to Web Client.
2. Create an Item/File Folder/Design/DFCO or any other BO.

3. Navigate to the Attachments tab of Item and add a file, navigate to the Files tab of
File Folder/Design and add a file checkin Design/File Folder, navigate to Affected
Files tab of DFCO and add file.

4, Create an ECO for Item and navigate to Affected Items > Redline Attachments tab,
Select a file, redline the file save and close AutoVue window OR, Navigate to Files
tab of Design/File Folder, select a file and redline the file, save and close AutoVue
window OR, Navigate to Affected Files tab of DFCO, select a file and redline the
file, save and close AutoVue window.

Actual Result: Redlined Attachments, Affected Files, Files, and Attachments table
are not auto refreshed.

Expected Result: Redlined Attachments, Affected Files, Files, and Attachments table
should be auto-refreshed with Has Been Redlined icon.

Workaround: Manually refresh the page. Additionally, the previous AutoVue
integration implements window on unload event which will be called when the
browser window is closed to refresh the Web Client. This becomes not applicable now
as AutoVue is a separate application not inside the window.

25132140
Main Install

Issue: FAIL TO START FM WITH SSL BETWEEN VUESERVLET AND AUTOVUE
SERVER

Steps to Reproduce:

1. Configure SSL between VueServerlet and AutoVue server refer to AutoVue Guide,
http:/ /docs.oracle.com/cd/E69054_01/otn/pdf/E69005_01.pdf

2. After configuration, start FM.
Actual Result: Fail to start FM.
Expected Result: Start FM successfully.
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Workaround: Import Agile certification to AutoVue and do not enable SSL on the
AutoVue side.

25214270
2D Pro Integration
Issue: [AV21.0.1]WINDOWS AND LINUX BUILD DATA IS INCONSISTENT
Steps to Reproduce:
1. Login to Web Client.
2. Create one Part, upload files to the Attachments tab.
3. View the files.
Actual Result: In the AutoVue window:
Linux server: File Versions. Build Date for each file is 2016-11-25.
Windows server: File Versions. Build Date for each file is 2016-10-16.
Workaround: N/A

25214886
Folders, Files & Attachments

Issue: <FF>REFRESHING THE PAGE GOES BLANK AFTER ADDING FILE TO
SELECTED FOLDER IN DFCO

Steps to Reproduce:

1. Login to web client in Firefox browser.

2. Create a DFCO and add files.

3. Checkout one of the affected files.

4. Select a row and click on Add->To Selected File Folder.
5. Refresh the page.

Actual Result: Observe that, the page goes blank. The user needs to close the
browser and reopen it again.

Workaround: N/A

25236260
Electro Mechanical Pro Int

Issue: REGRESSION,AGILE PLM. PRINT SINGLE FILE WHEN VIEW MULTIPLE
FILES

Steps to Reproduce:

1. Log in to the Agile system, create a Part/Folder/Design.
2. Import several files into this folder.

3. View multiple files by multi-selecting them.

4

In the viewer, click on the Print icon to try to print the current file.
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Actual Result: All files are listed and printed out. The document names are
duplicated as the current file in the Print Progress window. Check print out
results. All of the files are printed out with their name (file name is correct this
time).

Expected Result: In Agile935 + AV 21.0.0, view multiple files, then click the print
icon inside the view. Only the current files are listed and printed out.

Workaround: N/A

25313870
Folders, Files & Attachments

Issue: SMART URL VIEW SHOWS ERROR WHILE VIEWING FILE OF FILE
FOLDER, DESIGN ADDED BY DRAG

Steps to Reproduce:

1. Log in to Web Client.

2. Create a File Folder or Design.

3. Navigate to the Files tab and add a file and check it in.
4

Create an Item, navigate to Attachments tab and add the File Folder or Design by
dragging and dropping.

5. Open a new tab of the browser and type the smart URL and press Enter.

http:/ / <AppServerHostName>:<Port>/Agile/link/Part/<PartNumber>/Rev/In
troductory/fles/<FileName>/view

Actual Result: "! File <FileName> Not Found on Item:" message is displayed.
Expected Result: The file should load in the AutoVue window.
Workaround: Design files should be added selecting Add > Add By Search.

25315234
Gantt Chart

Issue: OVERLAY ICON DOES NOT REFRESH AFTER GANTT UPDATE AND 2ND
TIME UPDATE FAILS

Steps to Reproduce:

Case 1: In a Multi-Project Gantt chart, insert a new Activity and update Gantt. Check
the overlay icon of newly inserted activity.

Result: Overlay icon of the newly inserted activity does not change to the green color.

Case 2: Insert another Activity /Gate in the same project tree and update Multi-Project
Gantt.

Result: Update fails with error saying "Update Failed! Activity -10006 doesn't exist".
1. Log in to Web Client.
2. Create a project P1 with sub tasks T1 and T2.

3. Do a Save As from the root project, P1, as another project, P2.
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4. Edit the General Info page of project, P1, and add root project, P2, to its 'PLM
Reference' field and save.

5. Launch Gantt chart from root project P1.
6. In Multi-Project Gantt, insert a new task, T3, to project P1.
7. Update Gantt chart and check the overlay icon of task T3.

Result: Task, T3, overlay icon is not changing to green color even after Gantt
update

8. Insert another Activity/Gate to Project P1 tree.
9. Update the Multi-Project gantt chart again.

Result: It throws an error message saying "Update Failed! Activity -10006 does not
exist".

Workaround: Click the Refresh from Server button right after every Save action in
Multi-Project gantt.

25343347
Fileload

Issue: UNABLE TO UPLOAD FILE THROUGH FILE LOAD FOR FOLDERSUBCLASS
ATTRIBUTE FROM WEB CLIENT

Steps to Reproduce:

Preconditions: In Java Client, the Custom vault should be configured for the file server
and Fileload privilege should be enabled.

1. Login to Web Client.
2. Create an Item object.
3. Prepare an index file for FILE.

INDEX FILE:
ITEM, <ItemNumber>, \ \ <SharedFolder>\Filename,FILE,Description="FileIntrod
uctory",FolderSubclass="File Folder"

4. Tools and Settings > File Load > browse for the index file and click on Load.

Actual Result: The file is not loaded to the Item object and in the log file, the
following is displayed:

"Row
#1:ITEM,<ItemNumber>,, \\ <SharedFolder>\Filename, FILE,Description="Filelntr
oductory”,FolderSubclass="File Folder" Invalid Attachment Subclass."

Expected Result: File should be loaded to Item object.

Workaround: Able to upload file through file load for the FolderSubclass attribute
from Java Client.

25344270
Resource Management

Issue: TEAM TAB-ADD RESOURCE DIALOG GIVES APPLICATION ERROR FOR
INVALID %ALLOCATION VALUE
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Steps to Reproduce:

Preconditions: The user's preferred Number Format should be set to "Apostrophe as
thousands separator, Period as decimal indicator” OR "No thousands separator, Period
as decimal indicator".

1. Log in to Web Client as a user whose preferred Number Format is any of the above
mentioned formats

2. Create a project P1.
3. Go to Team tab and click Add.

4. In'Add Resources' dialog, enter all the field values and enter %allocation = 123,45
and click Add.

Actual Result: Application Error.

Workaround: Input a number with the default number format like *123.45". You can
also edit this number on the Team tab directly.

25350146

Electro-Mechanical Pro Int

Issue: [LINUX]PRC2HSF @ /AVS/BIN/HOOPS FOLDER
Steps to Reproduce:

Preconditions: Set up Linux server with A936+AV21.0.1:
1. Enable preference of Generate Mobile streaming file
2. Point the viewer host in fileserver locations

3. Check the 3D view checkbox for 3D filetype.

Steps:

1. Log in to Web Client.

2. Add a supported 3D file to a BO.

3. Validate the .hsf file generation

Actual Result: prc2hsf file @ / AVS/bin/hoops folder does not have complete
privilege and therefore does not allow the generation of the mobile streaming files.

Expected Result: Mobile streaming file [.hsf] file should be generated.
Workaround: Provide the permission 777 to file prc2hsf @/AVS/bin/hoops folder.

25351209

Standard Reports

Issue: MY OPEN ACTION ITEMS REPORT FAILS WITH UNEXPECTED ERROR
Steps to Reproduce:

1. Log in to Web Client.

2. Go to Standard Reports > Program & Portfolio Reports > End User Reports.
3. Execute My Open Action Items Report.
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Actual Result: The following error occurs: "ERROR: An unexpected error has
occurred. Please contact your system administrator. Error Detail: Node 2 does not
exist in the cache. It may have been deleted already."

Workaround: There is no workaround in Standard Reports, however, the user can go
to the My Assignments tab and select Action Items in Views to see all the Action Items
assigned to that user.

25351860

Standard Reports

Issue: PORTFOLIO STATUS REPORT GIVES UNEXPECTED ERROR
Steps to Reproduce:

1. Log in to Web Client.

2. Go to Standard Reports > Program & Portfolio Reports > Porfolio Reports and
execute the Portfolio Status Report.

Actual Result: Report output gives an error saying "ERROR: An unexpected error
has occurred. Please contact your system administrator. Error Detail:
java.lang NullPointerException".

Workaround: N/A

25363283
Import

Issue: PGC BOS IMPORT FROM EXCEL GETS INCORRECT TYPE IF THE
STRUCTURE IS COMPLICATED

Steps to Reproduce:

1. Log in to Web Client. Create a Spec: HM_SP01, for Homogeneous Part Level, add
AL and Lead in Substance tab, set a proper threshold PPM level.

2. Create two Parts: T_P03, T_P04, create one Mfr. Part: T_MFP02, create one Part
Family: T_PF02. Release T_P04 with version: 1.0.

3. Create a Homogeneous Material Declaration: AU_HM_MD001, add HM_SP01 as
spec.

4. Create an Excel file with the created Part/Mfr.Part/Part Group, and mix use of
Sub Part/Material /Substance Group in BOS.

5. For AU_HM_MDO001, click Actions > Microsoft Excel > Import from Excel, to
Import the created Excel file.

Actual Result: There is an error message when the user clicks Import: Incorrect file
type for this import.

Expected Result: There should be no such error and all of the BOS structure should
be imported.

Workaround: Import for each Item /Mfr. Part/Part Group separately. If the user still
gets the same error message, add BOS structure by Web Client.
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